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Introduction 
StudyMate Author® by Respondus® is a Windows authoring tool that makes it easy to 
create Flash-based learning activities and games. When creating a StudyMate file, the 
focus is on the substance of a topic, not the requirements of a particular activity or game. 
This is a more natural approach for instructors and makes it easier to use content that 
might already exist in other formats.   
 
Four types of items can be created or imported by StudyMate Author: No Answer items, 
One Answer items, Multiple Choice, and Calculated items. All four item types can reside 
in the same StudyMate file.  
 
“No Answer” Items 
A “No Answer” item consists of a fact, a statement, or a body of text. The following fact 
would be an example of a No Answer item: Albert Michelson determined the speed of 
light in 1879. The StudyMate Author activities that can be generated with No Answer 
items include: 
 Fact Cards  
 Fact Cards + 
 
“One Answer” Items 
A “One Answer” item has a word/phrase that is associated with another word/phrase. A 
common example is a glossary “term” that has a related “definition.” Another example is 
a fill-in-the-blank “question” in which the “answer” is a specific word or phrase. The 
StudyMate Author activities that can be generated using One Answer items include: 
 
 Flash Cards 
 Pick a Letter 
 Fill in the Blank 
 Matching 
 Crosswords 
 Glossary 
  
“Multiple Choice” Items 
“Multiple Choice” items are questions that have multiple distracters but only one correct 
answer. The StudyMate Author activities that can be created with Multiple Choice items 
include:  
  
 Quiz 



 Challenge 
 
"Calculated" Items 
"Calculated" items, sometimes known as algorithmic items, require students to apply a 
mathematical formula to answer the question presented.  Calculated items are designed 
for using variables with random values, based on a specified range, that are automatically 
generated for each variable in the question.  The StudyMate Author activities that can be 
created with Calculated items include: 
 
 Quiz 
 Challenge 
 
StudyMate Author exports the activities and games in Macromedia Flash (.swf) format 
and can publish activities directly to systems such as Blackboard, WebCT CE, and 
WebCT Vista.  
 
 
Computer Requirements 
StudyMate Author requires Windows 98 or higher, 32 MB of RAM, 5 MB of free hard 
disk space, and at least an 800x600 monitor resolution (1024 x 768 recommended). 
Internet Explorer must have the Macromedia Flash Player installed (version 7.0 or 
higher).  
 
StudyMate Author exports activities in Macromedia Flash 7.0 format (.swf). StudyMate 
Author additionally offers direct integration with ANGEL (version 6.3 and higher), 
Blackboard Learning System (version 6.0 or higher), WebCT Campus Edition (version 
4.0 or higher), and WebCT Vista (version 3.0 or higher).  
 
 
Installation & Setup 
The StudyMate Author installation program can be downloaded from 
www.respondus.com. To begin the installation process, locate the StudyMate.exe file 
that was downloaded to your hard drive. Double-click the file to start the StudyMate 
Author installation program and follow the instructions on the screen. Once StudyMate 
Author is installed, start the program by double-clicking the StudyMate Author icon that 
appears on the Windows desktop. Or, follow these steps to start the software. 
  
 Click [Start] from the Windows desktop 
 Click [Programs] 
 Click [Respondus] 
 Click [StudyMate Author] 
 
The first time you start StudyMate Author (and each time thereafter until the program is 
registered), you will be presented with a screen that provides the “Product ID#”. The 
Product ID# is used to obtain the Activation Password (see below) which is needed to 
complete the installation. 



 
 
 
 
Activation Password 
Once the StudyMate Author installation program is finished, you will need to obtain a 
password from www.respondus.com to activate the installation. Be sure to have the 
StudyMate Author “Product ID#” (see previous paragraph) readily available. After you 
have directed your browser to www.respondus.com, go to the “Registration” section of 
the site. You have the choice of purchasing a permanent activation password for 
StudyMate Author or obtaining a 30-day trial password. In both cases you will be 
required to enter a valid e-mail address and the Product ID# that displays on the opening 
screen of StudyMate Author. Once the information is submitted, the activation password 
is immediately sent to the e-mail address you specified.  
 
Once the password is received by e-mail, it must be entered into the StudyMate Author 
program. If you haven’t done so already, start StudyMate Author and then enter the 
password when prompted (you may want to “copy and paste” the password from the e-
mail message in order to prevent typing mistakes). Click [OK] to continue. The 
StudyMate Author software is now activated, either permanently or for a 30-day trial 
period.  
 
 
Online Help & User Guides 
StudyMate Author includes a full-featured help system that includes an index and 
context-sensitive help. To view the on-line help, choose “Help Topics” from the pull-
down Help menu and select a topic. You can also press the F1 key from within 
StudyMate Author to obtain context-sensitive help. Throughout the program you will 
additionally see small buttons having a “?” symbol. When the button is clicked, 
information on that particular option or task is provided.  
 
A print version of the StudyMate Author User Guide is available from the Respondus 
web site (www.respondus.com). It can be downloaded for free.  
 
If you encounter a question that is not answered in the online help or in the StudyMate 
Author User Guide, you are encouraged to visit the “Support” section of the Respondus 
web site (www.respondus.com). There you will find a Knowledge Base and other 
resources.  
 
The remainder of this user manual is organized according to the four StudyMate Author 
menus: Start, Edit, Settings, and Preview & Publish. 
 
 



Start Menu  
Overview of Start Menu 
Opening a File 
 - Opening and Converting a Respondus file 
 - Downloading Publisher Test Banks 
Creating a File 
Import Wizard 

  - Format Requirements for Importing “Multiple Choice” Files 
  - Format Requirements for Importing “One Answer” Items 
  - Format Requirements for Importing “No Answer” Items 

Quick Copy Wizard 
 
 
Overview of Start Menu 
The Start menu provides the ability to Open a StudyMate Author file, Create a new file, 
and Import questions from a word processing, text, or IMS QTI file. The Quick Copy 
Wizard additionally provides an easy way to create an activity from an existing set of 
StudyMate files.  
 
A StudyMate file must be open before you can go to another menu in StudyMate Author. 
 
 
Opening a File 
From the Start menu, click the Open button. The following window will appear: 
 

 
 
Highlight a StudyMate project by clicking it once. To obtain information on the project, 
select one of the two center buttons located above the “Selected File” window at right. 
The “Item List” button (right of center) is used to view a list of the items contained in the 
highlighted file. To preview a particular item, click the “Title.” 
 



To open a highlighted file, click the [Open] button at the bottom of the window. 
(Double-clicking a file name will also open it.)  
 
StudyMate Author allows projects to be organized within sub-folders. For example, you 
may want to organize StudyMate projects by class, course, or subject matter. To create a 
new folder, locate the toolbar above the “Selected File” window and click the “Create 
New Folder” button located second from left. To navigate down a level within a folder, 
double-click the folder itself. To navigate up a level, click the “Up One Level” button 
located leftmost on the row of buttons.  
 
The [Search] button allows the text in a file to be searched prior to opening it (it can only 
be used if the “Item List” view is selected).  
 
The [Browse…] button, located on the lower left side of the Open window, allows you to 
locate a StudyMate file (.rsf) that is located elsewhere on the hard drive and copy the file 
to the StudyMate Projects folder. It does not move the file or open it directly; rather, it 
creates a new “Projects” folder based on that file.  
 
Opening and Converting a Respondus file 
The Browse button can also be used to select and then convert a Respondus project file 
(.rsp) or a Respondus archive file (.rsa, .rpa) to StudyMate format. To do so, click 
[Browse...] and then change the pull-down list for “Files of Type” to “Respondus Files 
and Archives.” Upon selecting a Respondus project or archive file, various options will 
be offered regarding the conversion of the Respondus file to StudyMate format. Select 
the desired options and click [OK] to complete the conversion. 
 
Note, the Import Wizard can also be used to convert a Respondus file to StudyMate 
format. 

 
Downloading Publisher Test Banks 
The [Download Test Bank] button is used to download publisher test banks that have 
been made available through the Respondus Test Bank Network (for more details, see 
http://www.respondus.com/testbank). To download a test bank, enter the File Code that 
has been supplied to you by the publisher. If applicable, also enter the password and any 
additional information that has been provided to you. StudyMate Author will then locate 
and download the test bank file. Since the file being downloaded is in Respondus format, 
it will need to be converted to StudyMate format. Following the download step, 
StudyMate Author will display various options regarding the conversion of the file to 
StudyMate format. Select the desired options and click [OK] to complete the conversion. 
 
 
Creating a File 
From the Start menu, select the Create button to create a new file. You prompted to enter 
a File Name and Description (both are required), as well as Author and Keyword 
information (optional). Click [OK] to create the file. You are now ready to add items to 
the file, using either the Edit menu or the Import Wizard.  



Import Wizard 
StudyMate Author allows the importing of No Answer, One Answer, and Multiple Choice 
items.  Calculated items can also be imported, but only if they are in Respondus (.rsp) 
format. For text imports, the file must be formatted according to the guidelines discussed 
later in this section. Once the text is in the proper formatting, the Import Wizard will 
guide you through the importing process, as discussed here.   
 
Step 1 
Start the Import Wizard and select the file format being imported:  
 
* MS Word (.doc), Rich Text (.rtf), Text (.txt) 
* IMS QTI (.xml) 
* Respondus (.rsp) or Respondus Archive (.rsa, .rpa) 
 
The first option (.doc, .rtf, .txt) is self-explanatory. If the file being imported is in one of 
these formats, then select this option. 
 
IMS Question & Test Interoperability (IMS QTI) is a XML standard that is supported by 
various e-learning systems (for more information, see 
http://www.imsglobal.org/question/). If an IMS QTI file is being imported, StudyMate 
Author will use only the multiple choice and true/false questions, filtering out the rest.  
 
Respondus is a separate authoring tool by Respondus Inc. that allows you to create 
assessment content for use with the leading course management systems (for more 
information, see http://www.respondus.com). Many question types from Respondus files 
(.rsp) or Respondus Archive Files (.rsa, .rsp) can be imported with StudyMate Author. 
 
Step 2 
If you are importing a Respondus or IMS QTI file, skip to the instructions provided in 
Step 3. If you are importing a MS Word, Rich Text, or Text file, the next screen in the 
wizard will ask whether the text being imported is formatted for Multiple Choice, One 
Answer, or No Answer items.  It’s important to note that only one type of question can be 
imported at a time from MS Word, Rich Text or Text formats (see the formatting 
requirements described below for each question type). To import more than one type of 
item to a StudyMate file, repeat the importing process. 
 
The next screen will remind you that the text formatting for Multiple Choice, One 
Answer, and No Answer items must follow the guidelines for the Standard Format, as 
discussed later in this section.  
 
Step 3 
The final screen of the wizard requires several actions. Click “Browse” to locate and 
select the file being imported.  
 



Next, indicate whether the items being imported should be appended to the currently 
open file or whether an entirely new StudyMate file should be created. If the second 
option is selected, you will additionally need to enter the name of the file being created. 
 
Each item being imported is given a “title.” If titles aren’t specified in the file being 
imported, StudyMate Author will create a title using the first 20 characters of the item 
wording. Alternatively, it is possible to specify “stem” text (ie., a prefix) that will then be 
followed by consecutive numbering starting with 001. For example, if you select the 
“Use stem...” checkbox and enter the text “Chapter1-” the title for the first item being 
imported will be Chapter1-001, the title for the second item will be Chapter1-002, and so 
on. (You do not have to enter stem text--this feature is entirely optional.) 
 
Click the [Preview] button to preview the file being imported and to see if there are any 
warning messages. If warning messages are shown at the bottom of the screen, you need 
to decide whether to make changes to the file being imported or whether to continue 
without making changes. (Note, if a Respondus file is being imported, an additional 
window containing conversion options will appear. Select the desired options and click 
[OK] to continue.)  Be aware that some warning messages don’t actually require that 
changes be made to the file being imported. For instance, StudyMate Author will 
generate a warning message if two items being imported have the same title (StudyMate 
Author will automatically place the number “2” at the end of the second title to make it 
distinct from the first). In this example, if you don’t care that StudyMate Author is 
making a minor change to the title, ignore the warning message. 
 
If you are satisfied with how the results look in Preview, click [Finish] to complete the 
import. The StudyMate file has is now created or appended. Switch to the Edit menu to 
further modify the file, or go to the Preview task to view the items.   
 
 
Format Requirements for Importing “Multiple Choice” Files 
StudyMate Author can import multiple choice questions from a MS Word document 
(.doc), a rich-text file (.rtf), or a text file (.txt). The .doc and .rtf files cannot contain 
images or embedded objects, such as tables. (If a StudyMate warning indicates that the 
document being imported contains images or embedded objects, the easiest way to strip 
these items is to save the file to .txt format.) 
 
Multiple Choice items must be organized in the “Standard Format” before it can be 
imported. The Standard Format for multiple choice questions has required elements and 
optional elements, each of which is described next. 
 
“Standard Format” for Multiple Choice Imports: Required Elements 
Each question must begin with a question number, followed by either a period “.” or a 
parentheses “)”.  
 
 Example:    3)   

Example:  3. 



The question wording must follow the question number. (Note: at least one space should 
be between the question number and the question wording.) 
 
 Example: 3) Who determined the exact speed of light? 

Example: 3. Who determined the exact speed of light? 
 
 
Each answer must begin with a letter (A-J) followed by a period “.” or a parentheses “)”.  
 
 Example:  3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   b. Albert Michelson 
   c. Thomas Edison 
   d. Guglielmo Marconi 
 
 
“Standard Format” for Multiple Choice Imports: Optional Elements 
A Title can be imported with each multiple choice question. If a title is not provided for a 
question, the first set of characters of the question wording will be used as the question 
title in StudyMate Author. Titles must be placed at the beginning of a question and begin 
with “Title:” followed by the actual text for the title. If the title exceeds 20 characters, the 
remaining characters will be dropped during the import.  
 
 Example: Title: Speed of Light 

  3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   b. Albert Michelson 
   c. Thomas Edison 
   d. Guglielmo Marconi 
 
The correct answer for a multiple choice question can be indicated in two ways. First, 
you may place an asterisk (*) directly in front of the answer choice (do not put a space 
between the asterisk and the answer choice). 
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   *b) Albert Michelson 
   c) Thomas Edison 
   d. Guglielmo Marconi 
  
The second option is to place a list of correct answers at the end of the file. The list must 
begin with the word “Answers:” and must be positioned at the end of the file.  



 Example:  Answers: 
1. A 

   2. C 
   3. B 
 
Note that only letters “A-J” should be used to indicate a correct answer since StudyMate 
Author activities only support a maximum of 10 answer choices per question. Also note 
that any text that appears after the answer list will be ignored. 
 
If neither of the above methods is used to specify a correct answer, StudyMate Author 
will automatically select the letter “A” as the correct answer. You will be warned if a 
question does not have a correct answer specified for it prior to completing the import.  
 
Answer “Feedback” can be imported with multiple choice questions by placing the 
feedback immediately after the question wording and beginning the line with the @ 
symbol. (Note: There must be at least one space between the @ symbol and the feedback 
text.) 
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
 
@ Albert Michelson was the first American to win the Nobel 
Prize in Physics (1907) for his measurements of the speed of 
light. His experiments laid the groundwork for Einstein’s 
Theory of Relativity. 

 
   a. Albert Einstein 
   *b) Albert Michelson 
   c) Thomas Edison 
   d. Guglielmo Marconi 
 
The “Topic” and “Difficulty” level of Multiple Choice questions can also be specified in 
a file prior to the import. This is explained below in the section “Importing a Topic or a 
Difficulty Level.” 
 
 
Format Requirements for Importing “One Answer” Items 
At the start of the Import Wizard, indicate that you are importing a .doc/.rtf/.txt file and 
on the next screen select the “One Answer” option. Prior to selecting the file in the next 
step, make sure the text is formatted according to one of the two formats supported by 
StudyMate Author: a “standard format” as described next or in WebCT’s glossary 
format.  
 
“Standard Format” for One Answer Imports 
Standard Format syntax for One Answer items is as follows: 
 



 <term1> 
 <definition1> 
  <blank line1> 
  <blank line 2> 
 <term2> 
 <definition2> 
 
This translates into the following example: 
 
  Albert Michelson 
  Determined the exact speed of light 
 
 
  Albert Einstein 
  Developed the General Theory of Relativity 
 
It’s important that at least two blank lines appear after each item. That’s because a single 
blank line indicates a new paragraph for the same item, not a new item altogether. Also 
note that enhanced formatting such as bold and italics will be retained by StudyMate 
Author when items are imported from a .rtf or .doc file. However, StudyMate Author will 
prevent you from importing files that contain images or embedded objects, such as tables. 
(If StudyMate Author warns you that the document being imported contains images or 
embedded objects, it may be easier to export the file to .txt format so that these objects 
are automatically converted to a suitable format, or dropped altogether.) 
 
The “Topic” and “Difficulty” level of One Answer items can be specified in a file prior to 
importing. This is explained below in the section “Importing a Topic or a Difficulty 
Level.” 
 
 
Importing WebCT Glossary Files 
WebCT, a popular course management system, has a glossary tool that can export items 
in .txt format. These files can be imported by StudyMate Author as One Answer items. 
The formatting is relatively simple: 
 
 : <term> 
 <definition> 
 
Here’s a specific example:  
 
  :Albert Michelson 
  Determined the exact speed of light 
 
  :Albert Einstein 
  Developed the General Theory of Relativity 
 



Note that only one blank line is required between items for this format, unlike the 
“Standard Format” described previously.   
 
 
Format Requirements for Importing “No Answer” Items 
A No Answer item is essentially a fact or brief text that has no answer associated with it.  
StudyMate Author can import No Answer items from a MS Word document (.doc), a 
rich-text file (.rtf), or a text file (.txt). However, the file must first be organized in the 
“Standard Format,” which is actually quite simple: 
 
  <fact1> 
  <blank line1> 
  <blank line 2> 
 <fact2> 
 
This translates into the following example: 
 
  Albert Michelson determined the exact speed of light 
 
 
  Albert Einstein developed the General Theory of Relativity 
 
 
It’s important to remember that this formatting requires at least two blank lines between 
each item. That’s because a single blank line indicates a new paragraph for the same 
item, not a new item altogether. Also note that enhanced formatting such as bold and 
italics will be retained by StudyMate Author when items are imported from a .rtf or .doc 
file. However, StudyMate Author will prevent you from importing files that contain 
images or embedded objects. (If StudyMate Author warns you that the document being 
imported contains images or embedded objects, it may be easier to export the file to .txt 
format so that these objects are automatically converted to a suitable format, or dropped 
altogether.) 
 
The “Topic” and “Difficulty” level of No Answer items can be specified in a file prior to 
importing. This is explained below in the section “Importing a Topic or a Difficulty 
Level.” 
 
 
Importing a ‘Topic’ or a ‘Difficulty’ Level 
The “Topic” and “Difficulty” level of a Multiple Choice, One Answer, or No Answer item 
can be specified in a file prior to importing it. To assign a topic to multiple items in a file, 
place the following tags before and after the items, respectively:  
 
 TOPIC:  <enter topic name here> 
 TOPICEND:  
 



For example, to place the following two questions into a topic called “Scientists” the 
following formatting would be used:  
 
  TOPIC: Scientists 
 
  3) Who determined the exact speed of light? 
  a. Albert Einstein 
  *b. Albert Michelson 
 
  4) Who formulated the General Theory of Relativity? 
  *a. Albert Einstein 
  b. Albert Michaelson 
 
  TOPICEND: 
 
If you prefer to designate a topic for each item being imported, it isn’t necessary to 
include the “TOPICEND:” tag after each question. For example, the following formatting 
is acceptable where a different topic is being assigned to both items: 
 
  TOPIC: Michelson 
 
  3) Who determined the exact speed of light? 
  a. Albert Einstein 
  *b. Albert Michelson 
   
  TOPIC: Einstein 
 
  4) Who formulated the General Theory of Relativity? 
  *a. Albert Einstein 
  b. Albert Michaelson 
 
  TOPICEND: 
 
Just remember to include a “TOPICEND:” tag any time you don’t want the topic to be 
attributed to subsequent questions or items.  
 
A similar approach can be used to designate a 1-5 difficulty level (1=low, 5=high) for 
items being imported.  
 
  DIFFICULTY: <enter a number between 1 and 5> 
          DIFFICULTYEND: 
 
For example, to assign the difficulty level of two questions to “3” the following 
formatting would be used: 
 
  DIFFICULTY: 3 



  3) Who determined the exact speed of light? 
  a. Albert Einstein 
  *b. Albert Michelson 
 
  4) Who formulated the General Theory of Relativity? 
  *a. Albert Einstein 
  b. Albert Michaelson 
 
  DIFFICULTYEND: 
 
 
If you prefer to designate a difficulty level for each item being imported, it isn’t 
necessary to include the “DIFFICULTYEND:” tag after each question. For example, the 
following formatting is acceptable where a different difficulty level is being assigned to 
both items: 
 
  DIFFICULTY: 5 
 
  3) Who determined the exact speed of light? 
  a. Albert Einstein 
  *b. Albert Michelson 
   
  DIFFICULTY: 3 
 
  4) Who formulated the General Theory of Relativity? 
  *a. Albert Einstein 
  b. Albert Michaelson 
 
  DIFFICULTYEND: 
 
However, remember to include a “DIFFICULTYEND:” tag any time you don’t want the 
difficulty level to be attributed to subsequent questions or items.  
 
One final note about the Topic and Difficulty tags. If you are importing a WebCT 
glossary file, only one topic and/or difficulty level can be specified in the file. In addition, 
the first tag must appear at the top of the text file.  
 
 
Quick Copy Wizard 
The Quick Copy Wizard is the easiest way to select and copy items from two or more 
StudyMate files. To begin, select the Quick Copy Wizard button from the Start menu. 
The first page of the wizard provides the option of creating a new file or opening an 
existing StudyMate file and then copying items to it. Make your selection and click 
[Next]. If you selected the option to create a new file, provide a name and description of 
the file. If you selected the option to use an existing file, open the desired file as 
prompted. Click [Next] to continue.  



The next page of the wizard prompts you to select the StudyMate files from which the 
questions will be copied. Highlight a file and click the [Select] button. Repeat this 
process until all files from which you want to select questions are selected. Click [Next] 
to continue. 
 
The next page of the wizard prompts you to select a source file from the previous step. If 
the selected file has items that have been assigned to “topics,” the list can be further 
filtered by selecting a topic from the “Show items by topic” list.   
 
You then have the choice of using Automatic Selection or Manual Selection. When 
Automatic Selection is chosen, the available number of questions for each type of item is 
displayed in the “Available to Select” column. In the next column, enter the number of 
questions to be selected for each type of item. When all entries are finished, click either 
the [Add to End of List] button or the [Insert Into List] button. Repeat this process for 
each of the source files.  
 
The Manual Selection option allows the items for each file to be viewed before making a 
selection. In fact, you can preview individual items by clicking the title or by searching 
the entire list of questions using the [Keyword Search] option at top right. To select 
questions from this list, simply click the narrow column furthest to the left--a mark will 
appear next to the question. When finished with the selections, click either the [Add to 
End of List] button or the [Insert Into List] button. Repeat this process for each source 
file.  
 
Note that the Automatic Selection and Manual Selection options may be combined. A file 
can also be reselected from the pull-down list and have additional items chosen from it. 
StudyMate Author will prevent you from selecting an item more than once.  
 
Once items have been added to the list at the bottom of the screen, the Difficulty values 
can be edited manually. To delete an item from the bottom list, or to move it to a different 
location in the list, click the blue title and select the desired option. Finally, notice that a 
tally of the questions appears at the top right corner of the lower grid. 
 
The next and final page of the wizard is self-explanatory. For example, to edit items in 
the file, select the option to go to the Edit menu. To preview the activities, select that 
option, and so on.  
 
Click [Finish] to complete the wizard.  
 
 
 
 



Editing a File 
Overview of Edit Menu 
Common Features Across all Item Types 
Item Types and Activities 
 1) No Answer 
  - Fact Cards 
  - Fact Cards+ 
 2) One Answer 
  - Flash Cards 
  - Pick A Letter 
  - Fill in the Blank 
  - Matching 
  - Crosswords 
  - Glossary 
 3) Multiple Choice 
  - Quiz 
  - Challenge 
 4) Calculated 
Adding Bold, Italics, Underline, and Super/Subscript 
Web Links 
Adding Images 
Inserting Audio 
Spell Check 
Keyword Searches 
Modifying, Rearranging, and Deleting Items 
A Rapid Authoring Technique for Creating Items  
Using an Item as the Basis for a New Item 
Copying Questions from Another StudyMate Author File 
 

Overview of Edit Menu 
The Edit menu in StudyMate Author allows new items to be added to a file or current 
items to be edited. Four types of items can be created: No Answer, One Answer, Multiple 
Choice and Calculated. Up to ten activities can be created from these items. 
 



 
 
 
Common Features Across All Item Types 
Four types of items can be created with StudyMate Author: No Answer, One Answer, 
Multiple Choice, and Calculated. To create a new item, select the desired type from the 
left side of the screen. The entry form to its right will change accordingly; the Flash 
activities that can be generated from that type of item are also listed. 
 
Each item allows the entry of a “Title.” A title can be up to 60 characters. If you do not 
enter a title, StudyMate Author will use the first 20 characters from the next data entry 
field.  
 
Two optional features are available with each edit form: Difficulty level and Topic. The 
Difficulty level can be set between 1 and 5 (1=Low, 5=High). Items can also be assigned 
to a Topic, either an existing one or a newly created one. The small buttons located to the 
right of the Difficulty and Topic options determine whether an entry for that item is 
required. If the asterisk is selected, it becomes a required entry field.   
 



Four buttons appear at the bottom of all edit forms. The [Add to End of List] button adds 
the current item to the end of the “Item List” (located at the bottom of the screen). Use 
[Insert Into List] to insert the current item to a specific position in the Item List. 
The [Clear Form] button will erase all data that currently shows in the form. Finally, the 
[Preview] button opens a browser-like window that shows how the item will appear 
when exported as a Flash activity. The Preview window, which can be selected at any 
stage in the editing process, includes a pull-down list at top that allows a different activity 
or game to be previewed.  
 
At the bottom of the Edit menu, the “Item List” displays the title, format, topic, and 
wording for each item in the file. The total number of items is shown at the top right of 
the list. By clicking the “title” of an item, a window containing the “properties” is 
displayed. It is here where you can modify, delete, or move the item, as well as use the 
selected item as the basis for an entirely new item. These features are discussed in the 
section “Modifying, Rearranging, and Deleting Items.”   
 
 
Item Types and Activities 
There are four types of items in StudyMate Author (No Answer, One Answer, Multiple 
Choice, and Calculated). Several Flash-based games can be generated from each type of 
item. These are described below. 
 
1) No Answer 
Use a No Answer item to enter a fact, statement, or any text that doesn’t have a precise 
answer. The following fact is an example of a No Answer item: 
 
  Albert Michelson determined the speed of light in 1879. 
 
The StudyMate Author activities that can be created with No Answer items include Fact 
Cards and Fact Cards+.  
 
Fact Cards 
Fact Cards are one-sided cards that display text on them. 
 



 
 
Click Next or Previous to scroll through the cards. Shuffle will randomize the deck of 
cards and Reset will return you to the first card in the deck.  
 
Fact Cards+ 
Fact Cards+ is identical to Fact Cards except that it additionally sorts the cards into 
topics. The topics are then displayed along the left side of the Flash object. An item can 
be assigned to a topic during the editing or import steps. 
 



 
 
2) One Answer  
A One Answer item has a word/phrase that is associated with another word/phrase. A 
common example is a glossary “term” that has an associated “definition.” Another 
example is a fill-in-the-blank “question” that has a specific word or phrase for the 
“answer.”  
 
 Example:  
  
  Term or Answer: Albert Einstein 
  Definition or Question: Developed the General Theory of Relativity 
 
The StudyMate Author activities that can be created with One Answer items include 
Flash Cards, Pick a Letter, Fill in the Blank, Matching, Crosswords, and Glossary. 
 
Flash Cards 
Flash Cards are two-sided cards that display the term/answer on one side of the card and 
the definition/question on the second side of the card.  
 



 
 
Click Flip Card to see the second side of the card. Select Next or Previous to scroll 
through the deck of cards. Shuffle randomizes the deck of cards and Reset returns you to 
the first card in the deck. The Display Other Side First option determines which side of 
the card is shown first.  
 
Pick a Letter 
Pick a Letter displays the definition/question at the top of the screen and has the user type 
or click the letters contained in the answer. If a letter appears more than once in an 
answer, all uses of that letter will be displayed when it is selected.   
 
 



 
 
If an incorrect letter is entered, 1 point (of a possible 5 points) is deducted for that 
question. A user can continue answering the question even after the point value reaches 
zero. 
 
Next Question proceeds to the next question in the list; no points are awarded if the 
answer isn’t completed before clicking Next Question. Hint reveals the next letter or 
character in the answer; one point is deducted for each hint until the point value for the 
item reaches zero. Show Answer reveals the entire answer; no points are awarded when 
this option is used. Reset starts the activity over again. 
 
Once the final item is answered, a score will be displayed.  
 
Fill In the Blank 
Fill in the Blank displays the definition/question in the top section and has the user enter 
the exact term/definition for the answer. If the answer isn’t exactly correct, StudyMate 
provides a hint based on the text entered in the previous attempt. One point (of a possible 
5 points) is deducted for each incorrect attempt. There is no limit to the number of 
attempts allowed, even if the point value for the item reaches 0.  
 



 
 
Next Question moves you to the next question in the list; no points are awarded if the 
answer isn’t completed before clicking Next Question. Hint reveals the next letter or 
number in the answer; one point is deducted for each hint until the point value for the 
item reaches zero. Show Answer reveals the complete answer; no points are awarded 
when this option is used. Reset starts the activity over again. 
 
Once the final item has been answered, a score will be displayed.  
 
Matching 
The Matching activity displays the definition/question in the top section and has the user 
select from one of the nine term/answer windows below. The answer windows don’t 
change until six correct answers have been revealed. At that time the nine answer 
windows are repopulated and the sequence repeats itself. 
 
It’s important to understand that the contents of the nine answer windows are randomly 
drawn from other items in the file. This works well if all One Answer items in the file are 
similar (eg. all items are persons, or all items are events, or all are definitions). However, 
if the One Answer items are a mixture of topics it may be desirable to exclude the 
Matching activity when generating Flash objects.  
 
 



 
 
There must be at least 9 One Answer items in a file before StudyMate will allow the 
Matching activity to be exported to a Flash object.   
 
Next Question moves you to the next question in the list; no points are awarded if the 
prior item isn’t answered before clicking Next Question. Show Answer reveals the answer 
for the item; no points are awarded when this option is used. Reset starts the activity over 
again. 
 
Crosswords 
A Crossword puzzle displays the “clue” (ie. the definition or question) at the bottom of 
the screen and requires the user to enter the “answer” in a corresponding, highlighted area 
of the grid. Answers are entered one letter at a time and it’s possible to switch to another 
clue before supplying any or all letters for the answer. Tallies for “correct” and “missed” 
letters are provided, with the possibility of multiple misses occurring for a single square.  
 
Play begins by clicking a white, unanswered square. A highlight appears around all letter-
boxes that comprise the answer, while the clue for the item is displayed at the bottom of 
the screen. The user can select a letter from the keyboard or from the palette of characters 
on the right side of the screen. International characters or numbers can be selected from 



the palette by first clicking the “>>>” button to reveal additional items. A puzzle is 
complete when all letter boxes have been solved. 
 

 
 
“Reveal Letter” displays the letter for the highlighted square and increases the “Missed” 
tally by one. “Solve Puzzle” reveals all remaining letters for the puzzle; no changes occur 
to the “Correct” or “Missed” tallies. The “Next Puzzle” button, when displayed, clears 
the current puzzle and skips to the next round (if one is available). The “Correct” or 
“Missed” tallies are unchanged when Next Puzzle is clicked.   
 
“Reset” refreshes the screen, clears the tallies, and starts the first puzzle again. Puzzles 
are not recompiled when the Reset button is clicked, just started again. 
 
If an answer has multiple words (“ICE AGE”), the blank space between words will be 
eliminated (“ICEAGE”). Special characters ($, %, #) and punctuation ( - ,?) are revealed 
at the start of a puzzle.  
 



Puzzles are compiled in the StudyMate Author authoring tool, before they are exported to 
Flash format. Thus, a crossword puzzle will be the same each time a student uses it.  
 
The Crosswords activity in StudyMate draws its data from the “One Answer” template. 
Only those terms/answers that have 15 or fewer characters will be used during the 
compilation of a puzzle. If the StudyMate file has more than about a dozen “One 
Answer” items, it can generate multiple puzzles (or “rounds”) from the available data. 
The Settings menu StudyMate Author lets the instructor specify the maximum number of 
rounds permitted for a puzzle, ranging from 1 to 10.  
 
The Settings menu also allows the instructor to control when crossword puzzles are 
compiled, which can take up to 4 seconds per puzzle round. The compilation time is 
dependent on how many “One Answer” items are contained in the file and how many 
puzzle rounds are being permitted (a Setting option). Another setting determines whether 
a puzzle is compiled each time the Preview task is selected in StudyMate Author or only 
if a change has been made to the StudyMate file.  
 
Glossary 
The Glossary tool provides an alphabetic listing of all One Answer items in the file. The 
term/answer is presented first, immediately followed by the definition/answer. Click a 
letter at the top of the screen to list the terms that start with that letter. The “other” 
category listed at the end of the alphabet will display terms that start with numbers, 
punctuation or special characters. The “All” option will list all One Answer items in the 
file alphabetically. To locate a glossary item that contains a particular word or phrase, use 
the Search feature.  
 



 
  
Note that it may be necessary to exclude the Glossary activity when generating Flash 
activities if the One Answer items don’t use a “term-definition” approach. For example, if 
the One Answer items are math problems in which the answer is a number, they won’t 
make a very useful glossary.  
 
 
3) Multiple Choice 
A Multiple Choice item displays a question, followed by a list with one correct answer 
and several distracters.   
 
 
 Example:  3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   b. Albert Michelson 
   c. Thomas Edison 
   d. Guglielmo Marconi 
 
Answer “feedback” can be included with Multiple Choice questions so that students can 
view additional information about the answer. For example, the following feedback 



might be displayed after a student answers the above question (regardless of whether the 
correct or incorrect answer was submitted): 
 

Albert Michelson was the first American to win the Nobel 
Prize in Physics (1907) for his measurements of the speed of 
light. His experiments laid the groundwork for Einstein’s 
Theory of Relativity. 

 
To add feedback to a Multiple Choice question, click the [Feedback] button to open an 
editing window. When the feedback text has been entered, click the [X] at the top right 
corner of the feedback window to close it.  
 
It’s possible to have the answer choices (distracters) displayed in random order for a 
question. Simply select the “randomize” box.  
 
The following StudyMate Author activities can be created with Multiple Choice items: 
Quiz and Challenge. 
 
Quiz 
A Quiz will show one multiple choice question at a time. The question wording is 
presented at the top of the screen with the answer choices shown below it. The correct 
answer is selected by clicking on the letter that represents it. 
 



 
 
After an answer is selected, the “Next Question” button will flash and stay highlighted. If 
feedback is set to display immediately after a question is answered (see the “Settings” 
section below), the screen will indicate whether the answer is correct or wrong and will 
display any feedback entered for that question.   
 
Reset starts the quiz again without any changes to the quiz itself. Shuffle also starts the 
quiz again but additionally randomizes and/or reselects the questions from a larger set of 
questions (again, depending on the “Settings” that have been selected).  
 
Upon completion of the Quiz activity, a score will be presented. The user will have a 
chance to review the incorrectly answered questions at this point.  
 
Challenge 
Challenge presents multiple choice questions in a fun, game-show environment. The 
game board consists of 5 topics, where each topic has 5 questions with point values that 
range from 100 to 500.  
 



 
 
At the start of the Challenge game, select the “One Player” or “Two Player” option. The 
Two Player mode additionally allows names to be entered for the players or teams.  
 
The game is started by clicking one of the point values below a topic. The question and 
answer choices are listed in the box below. The correct answer is selected by clicking on 
the letter that represents it. Players are immediately shown whether the answer is correct 
or wrong. If the answer selection is wrong, the correct answer will be displayed in green 
text and the incorrect answer will appear in red. If feedback is available for the question, 
it too will be displayed at this time. 
 
Challenge makes use of the “Difficulty” option that is available when multiple choice 
questions are created or imported with StudyMate Author. Questions will be distributed 
within a topic according to its original difficulty weighting (1=low, 5=high). Questions 
that don’t have a difficulty level assigned to it are treated as a “3” in terms of difficulty. If 
there aren’t enough questions within the various levels of difficulty, StudyMate Author 
will distribute the questions the best that it can.  
 



Challenge also uses the “Topics” option that is available when questions are created or 
imported with StudyMate Author. Questions that haven’t been assigned to a topic will be 
displayed under a “Mixed Topics” heading during the Challenge game.  
 
The point value indicated when a question is selected will be applied to the player’s total 
score for the game. If the player answers the question correctly, the “total score” will 
increase by that amount. Conversely, if the answer is answered incorrectly, the score will 
be reduced by that amount. Negative scores are very much possible! 
 
Show Answer will immediately display the correct answer to the question. Only 100 
points are deducted if the Show Answer option is used. Thus, a “wild guess” may not be 
the best strategy when playing against another partner or team since the penalty for using 
Show Answer may be less.  
 
4) Calculated 
Calculated items require students to apply a mathematical formula to answer the 
question. Calculated items are designed using variables. Random values, based on a 
specified range, are automatically generated for each variable in the question. Thus, 
Calculated items can be unique for each student, as illustrated in this example where 
values are inserted for {x} and {y}.  
 

Example: If a car is traveling {x} miles per hour for {y} hours, how far does it 
travel (in miles)?  

 
The following StudyMate Author activities can be created with Calculated Choice items: 
Quiz and Challenge . 
 
The StudyMate editor for Calculated items requires that the following sections be 
completed: 
 

• Question Wording 
• Formula 
• Variable Properties 
• Answer Properties 
• Value/Answer Sets 

 
Calculated – Question Wording 
In the Question Wording section, enter the text of the question just as you would for any 
other question type. However, instead of using specific numerical values to define the 
details of the question, instead use variables by specifying a name enclosed in curly 
brackets for each one. For example: “How long does it take to travel {x} miles at a speed 
of {y} mph?” 
 
Variable names can only contain letters and digits (the characters 0-9, a-z, and A-Z), and 
the “_” (underscore) character. However, the first character of a variable name cannot be 
a number and the variable names “e” and “pi” should not be used. 



You can use as many different variables as you need to define the question, and you can 
use the same variable name multiple times if necessary. 
 
Calculated - Formula 
In the Formula section, enter the mathematical formula associated with the question. This 
is the same formula that the student will be expected to use, and the same one that will be 
used to automatically calculate the correct answer for grading purposes. The same 
variables specified in the question wording will be used to indicate where each value 
should go in the formula. 
 
The formula can be typed into the edit field directly, or entered by selecting options from 
the pull-down lists provided for Variables, Functions, Operators, and Constants. Selected 
options will appear in the edit field at the current cursor location, and will overwrite the 
current selection (if any). 
 
The “Variables” list provides an easy way to select a common variable name. 
 
The “Functions” list provides the following supported mathematical functions: 
 

abs(x)  Absolute value of x. abs(-3) = 3. 
acos(x)  Arc-cosine of x in radians 
acosh(x) Hyperbolic arc-cosine of x in radians 
angle(x,y) Arc-tangent of x/y in radians. Uses signs to determine result quadrant. 
asin(x)  Arc-sine of x in radians 
asinh(x) Hyperbolic arc-sine of x in radians 
atan(x)  Arc-tangent of x in radians 
atan2(x,y) Same as angle(x,y) 
atanh(x) Hyperbolic arc-tangent of x in radians 
ceil(x)  Round x up to the nearest integer. ceil(2.1) = 3. ceil(-2.1) = -2. 
cos(x)  Cosine of x in radians 
cosh(x)  Hyperbolic cosine of x in radians 
exp(x)  Base e (Euler’s constant) raised to the power of x 
fact(x)  Factorial of x. fact(3) = 6. 
floor(x)  Round x down to nearest integer. floor(2.8) = 2. floor(-2.8) = -3. 
int(x)  Return integer portion of x. int(4.32) = 4. int(-4.32) = -4. 
ln(x)  Base e natural logarithm of x 
log(x)  Same as ln(x) 
log10(x) Base 10 logarithm of x 
max(x,y,…) Return the maximum of all supplied arguments. max(1,2,3) = 3. 
min(x,y,…) Return the minimum of all supplied arguments. min(1,2,3) = 1. 
mod(x,y) Modulus or remainder of x/y. mod(5,2) = 1. 
rand()  Return a random number between 0 and 1 
round(d,x) Round x to d decimal places. Halfway cases round away from 0. 
sin(x)  Sine of x in radians 
sinh(x)  Hyperbolic sine of x in radians 
sqrt(x)  Square root. sqrt(9) = 3. 
sum(x,y,...) Return the sum of all supplied arguments. sum(1,2,3) = 6. 
tan(x)  Tangent of x in radians 
tanh(x)  Hyperbolic tangent of x in radians 



Note that the values for trigonometric functions are expressed in radians, not degrees. For 
conversion purposes, Pi radians = 180 degrees. Also, for all formulas that have two 
correct answers (for example, the square root of 9 is +3 and -3), only the positive number 
will be treated as correct. 
 
After selecting a function from the list, the formula must be edited to replace the 
argument list with numbers or variables. For example, “round(d,x)” might be edited to 
specify a fixed number of decimal places and a variable to round, as in “round(3,{y})”, 
which would round the variable {y} to 3 decimal places. 
 
Functions can also be nested within a formula, as in “sqrt(abs({x}))”. In this case, the 
absolute value of {x} is evaluated first, followed by the square root of the result. 
Functions can be nested as deeply as necessary to properly calculate the answer. 
 
When entering numerical values, scientific notation is expressed in the format xEy, where 
x is the coefficient and y is the exponent. To convert numbers from scientific notation to 
standard notation, use x times 10 to the power of y. For example: 
 

• 3.2E4 equals 32000 
• -2E0 equals -2 
• 3.14E-2 equals 0.0314 

 
The “Operators” list provides the following standard mathematical operators: 
 

- Subtraction 
() Parentheses used to group elements for precedence 
* Multiplication 
** Power or exponent. For example, 2**3 = 8. 
/ Division 
+ Addition 

 
The “Constants” list provides the following commonly-used numerical constants: 
 

_e Base e or Euler’s constant (2.71828…) 
_pi Pi – the circle ratio (3.14159…) 

 
Some example questions and associated formulas might be: 
 

Question: How long does it take to travel {x} miles at a speed of {y} mph? 
Formula: {x}/{y} 
 
Question: What is the positive square root of {x}? 
Formula: sqrt({x}) 
 
Question: Compute sin(x) where x = {x} degrees. 
Formula: sin({x}/180*_pi) 



Calculated - Variable Properties 
Clicking the “Variable Properties” button in the Formula section displays the Variable 
Properties dialog. Here, each variable in the question wording and formula is listed by 
name, along with Minimum, Maximum, and Scale values for that variable. 
 
The Minimum and Maximum define the range of values each variable can be assigned, 
and the Scale specifies the number of decimal places each value should be allowed before 
the value is rounded off. 
 
You can click each cell in the grid to edit the specific minimum, maximum, or scale value 
you want to change (the variable names cannot be edited). In general, for a given variable 
the minimum must be less than or equal to the maximum, and the scale must be greater 
than or equal to 0 and less than or equal to 5. 
 
Calculated - Answer Properties 
Clicking the “Answer Properties” button in the Formula section displays the Answer 
Properties dialog. Here you can specify values for answer scale and acceptable tolerance, 
as well as a unit name if required. 
 
Answer scale can be specified in Decimal Places. If the answer scale is specified in 
decimal places, the value must be greater than or equal to 0 and less than or equal to 5, 
just as with the scale values specified in the Variable Properties dialog.  
 
Answer tolerance is the amount that the student’s answer can deviate from the calculated 
answer and still be considered correct. It can be specified as a numeric value or as a 
percentage of the answer value. 
 
If you choose to require a unit name, comparisons with the name entered by the student 
will be case-insensitive and space-insensitive. 
 
Calculated - Value/Answer Sets 
Clicking the “Value/Answer Sets” button below the Formula section displays the 
Value/Answer Sets dialog. Here you can generate sets of variable values and calculate the 
associated answers using the formula previously entered. When the Calculated item is 
presented to the student, one of these value sets will be randomly chosen to populate the 
variables in the question wording and the formula, and the associated answer will be used 
to grade the student’s response. 
 
The grid displays a list of numbered value/answer sets. The number of sets available can 
be selected from the “Number of Sets” pull-down list. If images or equations are included 
in the question wording, a maximum of only 10 sets can be selected. The contents of this 
list will vary, depending upon the complexity of the question wording. For each set, the 
generated values for each variable are shown, and the individual cells can be clicked to 
edit those values. Note that any manually-entered values must be within the range 
specified by the variable minimum and maximum in the Variable Properties dialog. The 



answers cannot be edited; instead, the “Update Answers” button can be clicked to 
recalculate the answers for all value sets.  
 
Feedback 
Answer “feedback” can be included with Calculated item so that students can view 
additional information about the answer. For a Calculated item however, the feedback 
would need to be very generic due to the multiple value/answer sets.   
 
To add feedback to a Calculated item, click the [Feedback] button to open an editing 
window. When the feedback text has been entered, click the [X] at the top right corner of 
the feedback window to close it.  
 
 
Adding Bold, Italics, Underline, and Super/Subscript 
StudyMate Author makes it possible to add bold, italic, and underline to words. Simply 
highlight the text you want to modify and click the appropriate [B], [I], or [U] button on 
the tool bar. The text will immediately change to the selected formatting. The superscript 
[X2] and subscript [X2] tools function in the same manner. To remove the formatting, 
highlight the text again and reselect the corresponding button from the toolbar.   Caution 
should be used when using formatting other than bold, italic, and underline in Calculated 
items. When advanced formatting (subscripts/superscripts, images and the equation 
editor) is used in Calculated items, StudyMate Author must store each variation of the 
problem as an image instead of as text data, which greatly increases the size of the 
published Flash object. 
 
 
Web Links 
The Web Links tool on the toolbar lets you add a link to a website or to a file that is 
located on another web server. A new browser window will open when the user clicks on 
the web link from within the Flash activity.  
 
To create a web link, select the Web Link icon from the StudyMate Author toolbar and 
then follow the instructions for adding a web link. A link to a specific web page can be 
created, or you can create a link to a media file that resides on another server. In both 
cases, you will be prompted to enter the text that is to be displayed for the link itself.  
 
A Web Link cannot be used if a text field already has advanced formatting, such as 
images, equations, tables, super/subscript. Similarly, if a text field has a Web Link, you’ll 
be prevented from adding advanced formatting, such as images and equations. 
 
 
Adding Images 
Images can be added to most text fields in StudyMate Author, but should be used 
sparingly because they can significantly increase the size of the Flash object.  
 



From the Edit menu, position the cursor in the text field where you want the image to be 
added. Then click the “Insert image” icon on the toolbar, which is represented by a 
camera. A pop-up window will let you navigate to and select the image, provided that it 
is in one of these formats: bmp, gif, jpeg, png, pcx, and emf. 
 
After selecting an image, the following window appears: 
 

 
 
If the image is over 400 x 300 pixels, StudyMate Author will reduce it to the required 
size. An image can be made even smaller by manually adjusting the value for the “Scale 
to” field.   
 
Alternate text for images can be entered in the field provided. Although alt text isn’t 
currently supported in the Flash objects exported by StudyMate Author, it is expected in 
a future release.  
 
Click [OK] to close the window and return to the Edit menu. You will now see a set of 
green characters like <PIC_1> that represents the image. Be sure to preview all images 
prior to saving the item to the file. This will assure that the image size and position is as 
intended.  
 
To delete an image, position the cursor in the same field where the item is located. Then 
click the “Insert Image” icon on the toolbar (the camera icon) and select the option to 
delete an existing image or file. 
 
It’s important to understand that images can significantly increase the size of the final 
Flash object, particularly if high-color photos and images are used. A high-color image 
may be three times the size of a similar image that uses 256 colors. Also keep in mind 
that Flash objects work differently than HTML pages. Whereas an HTML page will 
begin displaying the content for a page while it loads the remaining elements, a Flash 
object must be fully downloaded before anything can be viewed.  
 



If more than 10 images are contained in a StudyMate file, consider splitting the file into 
separate Flash objects. This will reduce the amount of time it takes for a student to 
download the object from a web server. The Preview task available from the “Preview & 
Publish” menu displays the overall size of the Flash object. This will help you determine 
whether a Flash object is becoming too large.  
 
 
Inserting Audio 
The Insert Audio tool allows for audio to be embedded directly into StudyMate activities.  
This feature should be used sparingly since audio files use large amounts of space and 
can significantly increase the size of the Flash object. (Consider placing larger audio files 
on a separate server and using the Web Link tool in StudyMate Author instead.) 
 
To embed an audio file, from the Edit menu, position the cursor in the text field where 
you want the link for the embedded audio file to appear.  Click the “Insert audio” icon on 
the toolbar, which is represented by a musical note surrounded by sound waves.  The 
following pop window will appear:  
 

 
 
First, indicate the audio format of the file being selected, MP3 or WAV.  MP3 formats 
are preferable as they are higher in quality with a smaller file size.  However, MP3 files 
require separate, more advanced software to create them, and must be encoded to the 



proper sample rate (11, 22 or 44.1 KHz) and desired bit rate (16 Kbps - 320 Kbps).   
WAV files are lower in quality and have a larger file size.  However, WAV files can be 
created easily on a Windows-based PC with a microphone or headset using "Sound 
Recorder" in Start > All Programs > Accessories > Entertainment with the setting format 
"PCM" and attributes "22.050 KHz, 16bit, mono. 
 
Next, choose the [Browse] button to browse to a location on your hard drive to where the 
Audio file is located. Once a file is selected, click [Open].  MP3 files cannot be altered 
(sampled) within StudyMate Author; instead they must be encoded properly during the 
capture process.  However, compression quality and size can be selected for 
uncompressed WAV files which can be stored as 8-bit mono with a sample rate of 5.5, 
11, or 22 KHz.  Higher sample rates increase the quality but use much more space and 
create a much larger flash file.   
 
The overall size of a StudyMate activity can be determined within StudyMate Author by 
going to the >Preview & Publish Tab > Preview >Preview the File.  At the bottom of the 
preview window itself, a number will be displayed, such as "Flash object size = 168 K".  
It is important to note that a file size of 480 K will require about 2 minutes to download 
using dial-up, but often less than 10 seconds using a broadband connection. 
 
The next step is to enter the text for the link that the user will click to hear the audio file.  
The audio file can be previewed if desired.  If satisfactory, choose [Finish] to complete 
the embedding of the audio file. 
 
When using audio files with other advanced formatting features (subscripts/superscripts, 
the equation editor, images, and web links) it is important to understand that StudyMate 
stores the wording for a question or answer choice as an image and not text data.  In this 
situation, the link for the audio clip will appear after the question text, and the phrase 
"[clip 1 below]" will appear in place of the text for the link. .   
 
 
Equation Editor 
The process of adding equations is similar to how images are added. From the Edit menu, 
position the cursor at the place in the text where the equation is wanted. Then click the 
“Equation Editor” button on the toolbar, which is represented by a summation symbol. 
The Equation Editor will open and you can begin creating the equation. The Equation 
Editor in Respondus works almost identically to the one that is available with Microsoft 
Word and WordPerfect. So if you’ve used those equation editors, you’ll already know 
how to use this one. A key thing to learn about the Equation Editor is that the top row 
consists of “symbols” while the bottom row consists of “palettes”. If you select a 
“symbol” from the top row, it’s no different than if you selected the + or = sign on your 
keyboard -- except that the symbols from the Equation Editor eventually get displayed as 
graphics. When a “palette” is selected from the bottom row, text can be entered at various 
insertion points. It’s also possible to select a palette from the bottom row, click in an 
insertion point, and then select a symbol from the top row. For more information about 
the Equation Editor, refer to the online help that is available from within the editor.  



 
When finished editing the equation, exit the Equation Editor by either clicking the [X] 
that appears at the top right corner of the window or by selecting File from the menu bar 
and clicking Exit (do not simply minimize the Equation Editor). A new window appears 
that allows you to adjust the scaling of the equation. To accept the default setting of 
150%, simply click [OK].  
 
Alternate text for equation images can be entered in the field provided. Although alt text 
isn’t currently supported in the Flash objects exported by StudyMate Author, this feature 
is expected in a future release.  
 
Once an equation has been added and you return to the Edit menu, you will see a set of 
green characters like <EQ_1> that represents the equation image. Be sure to preview all 
equations prior to saving the item to the file. This will assure that the image size and 
position is as intended.  
 
To modify or delete an equation, position the cursor in the same field where the equation 
is located. Then click the Equation Editor icon on the toolbar and select the option to 
modify or delete an existing equation.  
 
 
Using MathType with StudyMate Author 
The Equation Editor in StudyMate Author is a special version of MathTypeTM by Design 
Science. If you frequently create documents with equations, you may find MathType is 
better suited to your needs. MathType is as easy to use as the Equation Editor and has 
many extra features to help you save time and create a wider range of equations.  
 
MathType is available in English, Japanese, German and French. For further information 
about purchasing MathType, contact your software dealer or Design Science directly: 
Design Science, Inc., 4028 Broadway, Long Beach, CA 90803, USA.  
 
 Toll free: 800-827-0685     International: 562-433-0685 
 Fax: 562-433-6969 
 Email: sales@dessci.com 
 World Wide Web: http://www.dessci.com 
 
If you already own MathType, you will need to reinstall it in order to have it work 
directly with StudyMate Author. MathType's readme file explains that it sets itself up to 
replace Equation Editor at the time that it's installed. So if you add a new application like 
StudyMate Author that uses the Equation Editor, you must re-install MathType. 
 
 
 
 
 
 



Power Edit 
The “Power Edit” task available from the Edit menu provides a table editor and a larger 
workspace for editing large blocks of text. 
 
Click in the field that you want to edit and then click the “Power Edit” button on the 
toolbar. Most tasks on the Power Edit toolbar also appear on the main toolbar. Only the 
Table editor is unique.  
 
Tables 
StudyMate Author makes it possible to insert and edit simple tables. From the Edit menu 
in StudyMate Author, position the cursor at the location where you want to insert the 
table. Then click the “Power Edit” button and select the “Insert Table” icon from the 
toolbar. When the next pop-up window appears, specify the number of columns and rows 
that should be included in the table. Click the [OK] button to return to the Power Edit 
window. You can now click within the cells of the table and enter the text.  
 
The width of the table cells can be adjusted by dragging the column lines. To edit other 
aspects of the table from the Power Edit menu, click within the table and select the 
desired action from the pull-down menu labeled “Table.” Use the “Insert” option to add a 
row or column to the table. Use the “Delete” option to delete a row or column, or to 
delete the entire table.  
 
Finally, keep in mind that tables will eventually be turned into graphics so that they can 
be displayed in the Flash object. So use tables sparingly since they will increase the 
overall size of the Flash object.  
 
 
Spell Check 
The Spell Check feature, which is located on the toolbar for the Edit menu, will search 
the currently open file for spelling errors and allow corrections to be made. Once the 
Spell Check feature is started, it will search for words that do not match items stored in 
the dictionary. If the word is not found in the dictionary, you are given the option to 
“Change” the word to one that is suggested, to “Ignore” the identified word, to “Change 
All” such words in the file to one you select, or to “Add” the word to the dictionary. If 
you want to make more detailed changes to the question, click the “Edit This Question” 
button, which will close the spell checker and make the question available for editing.  
 
Three dictionaries are included with a standard installation of StudyMate Author: 
American English, Canadian English, and British English. However, a free bundle of 
supplemental dictionaries can be downloaded from the Respondus website, including 
French, German, Spanish, Dutch, Finnish, and a comprehensive medical dictionary. 
 
 
 
 
 



Keyword Searches 
There are several places in StudyMate Author where the [Keyword Search] button 
appears, such as at the bottom of the Edit menu or when a file is being opened. This 
option allows you to search the currently open file or the file that is being previewed.  
 
Up to three words can be included in a search. When more than one word is used, you 
can choose whether a match is required of all words or any of the words. The search can 
be further filtered by selecting a topic from the pull-down list (if the items have been 
assigned to a topic). A final option allows answer choices and feedback to be included in 
the search.  
 
 
Modifying, Rearranging, and Deleting Items 
It is easy to modify, move, or delete an item in StudyMate Author. From the Edit menu, 
select an item from the “Item List” by clicking on its “Title.” A window appears that 
displays the entire properties for the question. On the right side of the window are several 
options. Click [OK] to close the window, click [Delete] to delete the item, click 
[Preview] to preview the item, and click [Move] to place the item at a different position 
in the Item List. If you select the [Modify] button, you will be returned to the Edit screen 
and the current properties for that item will be displayed in the form--modify the item as 
you like. When modifying an item, notice that the two buttons at the bottom of the form 
now indicate “Save Changes” or “Cancel Changes”. If you want to save the changes to 
the item, select the corresponding button. If you don’t want the changes to be 
implemented, select [Cancel Changes].  
 
 
A Rapid Authoring Technique for Creating Items  
If you plan to use the same basic content across the Multiple Choice, One Answer, and No 
Answer templates, the following rapid authoring technique can be employed.    
 
Starting with the Multiple Choice template, complete the fields as normal.  Before adding 
the item to the list, click the checkbox "After saving this item, use it to create a "One 
Answer" item".  The Multiple Choice item will be saved and StudyMate Author will 
automatically switch to the One Answer template. The One Answer template will be 
populated with text from the previously entered Multiple Choice item, but make sure the 
wording makes sense for the new One Answer item being created.   .  Before adding the 
new One Answer item to the item list, select the checkbox "After saving this item, use it 
to create a "No Answer" item".   Once the One Answer item has been saved, StudyMate 
Author will now switch to the No Answer template and populate it with the same text. 
Again, make sure the wording for the new No Answer item makes sense and then add it to 
the list.    
 
This rapid authoring technique sometimes requires that text be adjusted along the way.  
For example if a Multiple Choice item has a correct answer of "All of the Above", the 
text that will populate the One Answer template will not make sense unless you modify 
the "Term or Answer" field. .   



Using an Item as the Basis for a New Item 
To use an existing item as the starting point for a new item, locate the original item in the 
“Item List” at the bottom of the Edit menu. Select the item by clicking on the title. When 
the properties window appears, select the button [Use as Basis for New Item]. You will 
be returned to the Edit screen and the properties for the original item will be displayed in 
the form. The original title for the item will be modified slightly--for example, the 
number “2” will be added to the end of it. At this point you can rename the title and make 
any other changes you like. When finished, add or insert the item to the Item List.  
 
 
Copying Items from Another StudyMate Author File 
From the Edit menu it is possible to copy items from another StudyMate Author file. 
Click the button [Copy from another file] which is located on the left side of the screen. 
This will open a window containing the files stored in the default directory (\StudyMate 
Projects). Select a “source” file by double-clicking the file name or by clicking it once 
and selecting [Open].  
 

Tip: Before selecting a file, you can search the contents of the file by clicking on 
it once and then clicking the [Search] button. You can also preview the items for 
a file -- prior to opening it -- by highlighting the file name and clicking the “Item 
List” button.  Specific information for an item can be obtained by clicking its title. 

 
Once the source file is selected, a new window lists the items contained in it. An item can 
be selected by clicking the column furthest to the left. A checkmark will indicate that the 
item has been selected. When all the desired items have been selected, choose either the 
[Add to End of List] button or the [Insert into List] button to add the items to the 
currently open file.  
 
 
 
 
 



Settings Menu 
 Overview of Settings Menu 
 Settings for Item Types 
 Small Screen Device Settings 
 Other Settings 
  - Color Settings template 
  - Accessibility Support 
  - Language Settings 
 HTML Templates (advanced feature) 
  - Creating HTML Templates 
  - Template Marker Fields 
  - Full Page Templates 
  - Append Templates 
  - Overriding CSS Styles 
 
 
Overview of Settings Menu 
The Settings Menu allows you to specify settings for each activity. There is a setting tab 
for the each item type (No Answer, One Answer, and Multiple Choice/Calculated). The 
Small Screen Device Settings allow adjustment of the activities that can be created for use 
with iPods, Sony PSP, and certain other devices that have image storage capabilities.   
The Other Settings tab allows you to select color settings, “accessibility” settings, and the 
language in which the Flash activities will appear (English, French, German, etc.). The 
final tab, HTML Templates, allows you to control the design of the HTML file that is 
generated with the StudyMate Flash object during the publish step. 
 
 
Settings for Item Types 
Each StudyMate activity, except for Glossary and Challenge, has a setting that 
determines whether all items available for it will be displayed during each user session. 
The alternative is to display a subset of the available items during user sessions. For 
example, let’s say that the file contains 100 items that can be used with the “Pick A 
Letter” activity. Instead of including all 100 items each time the activity is played, you 
may prefer that 25 items be randomly selected each time. To do so, choose the “Select a 
fixed number” option and enter the number 25. (To clarify this example, all 100 items 
would be contained in the Flash object, but only 25 would be selected each time a student 
started the activity.) If you choose the option to have all items displayed during each user 
session, you have the choice of having the items delivered in random order or in the order 
that they appear in the StudyMate file. 
 
Additional settings are available for the Quiz activity. To have feedback shown 
immediately after an answer is provided by the student, select the option “Show feedback 
after each question”. The “Show score after quiz” option is self-explanatory. The 
“Review missed questions” option will allow the student, upon completion of the quiz, to 
review each question that was missed. 
 



Settings for Crosswords allow control of the number of puzzles (or “rounds”) included in 
a Flash object (ranging from 1-10). Another setting determines when puzzles are 
recompiled in the StudyMate authoring tool: each time the Preview task is started or only 
when a change has occurred to the StudyMate file.  
 
Finally, note that the Matching activity requires a minimum of 9 items and that the 
Challenge activity requires a minimum of 10 items. 
 
 
Small Screen Device Settings 
These settings allow adjustment of the files suitable for viewing on small screen devices 
such as iPod Nano, iPod Video, Sony PSP, and certain other devices that have photo 
storage capabilities.   
 
Two screen display sizes can be selected.    The first size is applicable for the iPod Nano 
(176x132), most flash based portables, and Palm PDAs.  The second is the larger iPod 
Video size (320x240) which is suitable for viewing on hard drive based portables, the 
Sony PSP and Windows CE PDAs. 
 
You may include/exclude any of the item types available in StudyMate Author:  "No 
Answer", "One Answer", "Multiple Choice", or "Calculated".  You may also exclude 
items that contain "Audio/Video objects" or "Web links" as these items will be converted 
to static images (generally BMP format) for viewing on the small screen device.   (For 
more information on small screen devices see the section “Exporting for iPods, PSP, and 
other Small Screen Devices”.) 
 
 
Other Settings 
The Other Settings tab, available from the Settings menu, provides color, accessibility 
and language settings for the Flash activities that are created with StudyMate Author.  
 
Color Settings 
A total of eight color templates are available in StudyMate Author. The default color 
setting is “Classic.” The color setting you choose will determine the look of the activities 
and games that are previewed or published with StudyMate Author. Note that if a 
“language setting” is anything other than English, that only the “Classic” color setting 
can be used.  
 
Accessibility Support 
Flash activities and games created with StudyMate Author allow navigation using the 
Tab/Enter keys, an important component of Section 508 (United States), SENDA 
Compliance (United Kingdom), and the Web Accessibility Initiative.  
 
The Flash activities will display in “high contrast” mode if the “High contrast display...” 
setting is selected.  
 



Another setting allows the creation of an HTML page that contains alternative text for 
screen reader applications. The web page created will contain all of the underlying data 
from the StudyMate file and can be used with assistive technologies compatible with web 
browsers, including input, magnification and screen reader technologies. If images appear 
in the StudyMate file, they will be replaced with the alternate text entered by the content 
author. 
 
More detailed information about StudyMate’s compliance with accessibility and assistive 
technologies is available from the Respondus web site at: 
http://www.respondus.com/products/accessibility.shtml. 
 
Language Settings 
The user interface for the Flash activities created with StudyMate Author can appear in 
six languages: Dutch, English, Finnish, French, German, and Spanish. To change the 
language setting within StudyMate Author, select the Settings menu, click the “Other 
Settings” tab and then choose the desired language from the pull-down list under 
“Language Settings.” 
 
 
HTML Templates 
During the “Publish” step, StudyMate Author generates an HTML file that provides the 
links used by students to launch the actual Flash game or activity. For example, students 
will click the HTML link “Challenge” to start the Challenge game.  
 
The HTML Templates tab provides default HTML templates for each publishing option 
supported by StudyMate Author. “Full Page” templates are used when a Flash activity is 
being published to an entirely new HTML page. “Append” templates are used when a 
Flash activity is being appended to an existing HTML page. Most users will select a set 
of default templates and then never revisit this setting again. However, it is also possible 
to create custom HTML templates, as explained below. 
 
Creating HTML Templates 
StudyMate Author offers advanced users a way to create custom HTML templates and to 
specify which template(s) to use when creating Flash objects with StudyMate Author. 
This allows great control over the content and appearance of the HTML page or page 
section that is published along with the Flash file. To create a custom template, you must 
be very familiar with HTML coding. We don’t recommend that you try creating a custom 
template unless you have this type of technical knowledge. The remainder of this section 
provides a technical description of how to create templates.  
 
As noted above, there are two types of StudyMate HTML templates: Full Page templates 
and Append templates. Full Page templates are used when publishing an entire HTML 
page, and must contain all the tags necessary for a complete HTML page. Append 
templates are used when appending to an existing HTML page, or replacing an existing 
activity. Append templates cannot contain certain tags associated with full pages. Both 



types of templates must contain a number of specific StudyMate marker fields that will 
be replaced during the publishing process with appropriate information. 
 
Templates are stored as files with the extension .HTM or .HTML in a folder named 
templates in the StudyMate Projects directory (the default location is c:\StudyMate 
Projects\Templates). Templates can be added to this folder manually outside of 
StudyMate, or via the [Add Template...] button on the HTML Templates tab. Several 
sample templates are provided with the StudyMate Author installation. 
 
All available templates are shown in the drop-down lists associated with each Course 
Management System or publishing option. In addition to any templates present in the 
templates folder, these lists also provide Default - Arial and Default - Times Roman 
selections. These default templates provide a simple page or section structure with 
sufficient information and hyperlinks but minimal clutter. They are identical to some of 
the sample templates provided with the installation. 
 
When a template is selected in one of the drop-down lists, it will be immediately 
validated to determine whether it is suitable for its intended purpose. If new templates are 
added to the templates folder while the HTML Templates tab is displayed, the [Refresh 
Template Lists] button can be used to refresh the drop-down lists so that they reflect the 
newly-available templates. 
 
Template Marker Fields 
StudyMate HTML templates must contain a number of marker fields that are replaced 
with appropriate information during the publishing process. These fields are used when 
creating templates to represent where the associated information should be located in the 
published file. In the following partial example template, the marker field 
{STUDYMATE PageTitle} would be replaced with the activity title entered by the user 
in the Publish Wizard: 
 

<html> 
<body> 
<title>{STUDYMATE PageTitle}</title> 
... 
 

The following is a complete list of the supported StudyMate marker fields and their 
descriptions: 
 

Marker Field Description Usage 

{STUDYMATE Script} This field will be replaced with a 
JavaScript function that is used to launch 
the Flash object.  

Required for all 
templates 

{STUDYMATE Title} This field will be replaced with the 
activity title entered by the user in the 
Publish Wizard. 

Required for all 
templates 



Marker Field Description Usage 

{STUDYMATE Text} This field will be replaced with the 
optional text or directions entered by the 
user in the Publish Wizard. If no such text 
was entered, this field will simply be 
removed from the published output. 

Required for all 
templates 

{STUDYMATE HorizontalLinks} This field will be replaced with a set of 
hyperlinks to all the published activities, 
each separated by a non-breaking space. 

Either a horizontal or 
vertical links field is 
required for all templates

{STUDYMATE VerticalLinks} This field will be replaced with a set of 
hyperlinks to all the published activities, 
each separated by a line break. 

Either a horizontal or 
vertical links field is 
required for all templates

{STUDYMATE ReplaceBegin} This field will be replaced with a special 
StudyMate HTML comment that marks 
the beginning of the replaceable section in 
a Full Page template. 

Required for Full Page 
templates; not allowed in 
Append templates 

{STUDYMATE ReplaceEnd} This field will be replaced with a special 
StudyMate HTML comment that marks 
the end of the replaceable section in a Full 
Page template. 

Required for Full Page 
templates; not allowed in 
Append templates 

{STUDYMATE PageTitle} This field will be replaced with a string 
suitable for use as a page title. Currently 
this is the same value as published for the 
{STUDYMATE Title} field, but later the 
user may be able to specify the value for 
this field separately in the Publish 
Wizard. 

Required for Full Page 
templates; not allowed in 
Append templates 

{STUDYMATE StyleID} This field will be replaced with a string 
suitable for use as a unique CSS style 
identifier within the HTML page. 

Optional for all templates

 
Full Page Templates 
Full Page templates are used when publishing to a new page in the Publish Wizard. They 
can contain any desired markup, provided they adhere to the following rules: 
 
1. They must contain <html> and </html> tags. 
2. They must contain <body> and </body> tags. 
3. They must contain the marker fields noted as “required” in the table above. 
4. The {STUDYMATE ReplaceBegin} field must come between the <body> and 

</body> tags in order to be recognized. 
5. The {STUDYMATE ReplaceEnd} field must come after a recognized 

{STUDYMATE ReplaceBegin} field in order to be recognized itself. 
6. With one exception, all other StudyMate marker fields must come between a 

recognized {STUDYMATE ReplaceBegin} field and a recognized {STUDYMATE 
ReplaceEnd} field in order to be recognized themselves. 



7. The one exception to rule #5 is that the {STUDYMATE PageTitle} field must not 
come between a recognized {STUDYMATE ReplaceBegin} field and a recognized 
{STUDYMATE ReplaceEnd} field in order to be recognized itself. 

 
Full page templates must contain a replaceable section that is marked by the 
{STUDYMATE ReplaceBegin} and {STUDYMATE ReplaceEnd}marker fields. This 
replaceable section is the part of the template that will be replaced using an Append 
template when replacing an existing activity in the Publish Wizard. All other StudyMate 
marker fields except for {STUDYMATE PageTitle} must lie within this replaceable 
section. 
 
Append Templates 
Append templates are used when appending to an existing page or replacing an existing 
activity in the Publish Wizard. Instead of a full page of markup, they are a section of 
markup that will either be appended to an existing page, or will replace an existing 
section in an existing page. Append templates can contain any desired markup, provided 
they adhere to the following rules: 
 
1. They must not contain <html> and </html> tags. 
2. They must not contain <head> and </head> tags. 
3. They must not contain <title> and </title> tags. 
4. They must not contain <body> and </body> tags. 
5. They must contain the marker fields noted as “required” in the table above. 
6. They must not contain the marker fields noted as “not allowed” in the table above. 
 
Overriding CSS Styles 
Some Course Management Systems make use of Cascading Style Sheets (CSS) to control 
the look and feel of their HTML pages. In some cases, it may be desirable to override this 
behavior within a StudyMate HTML template in order to exert more control over the 
appearance of the published information. 
 
This is the primary reason that the {STUDYMATE StyleID} marker field is supported. 
This field allows a template to specify a local CSS style block, associate that style block 
with a unique ID, then reference that style ID in the appropriate tag where it is desired to 
override existing CSS styles that may be in force. 
 
For example, the following partial template shows how to format the activity hyperlinks 
published by StudyMate Author so that they are in a 10-point bold sans-serif font, 
regardless of what CSS settings may be in force at that point within the page after it is 
published to the Course Management System: 
 

... 
<style type="text/css"> 
<!-- 
div#{STUDYMATE StyleID} a 
{ 
font-family: Arial,Verdana,Helvetica,sans-serif; 
font-style: normal; 



font-weight: bold; 
font-size: 10pt; 
} 
--> 
</style> 
<div id="{STUDYMATE StyleID}"> 
{STUDYMATE VerticalLinks} 
</div> 
... 
 

This technique is the same one used within the StudyMate sample and default templates 
to control hyperlink formatting in the presence of CSS. Regular formatting tags such as 
<font> and <bold> are also used in case the browser does not support CSS. The HTML 
comment around the contents of the <style> block is also necessary to prevent older 
browsers that do not support CSS from displaying the text within. 
 
 
 
 
 
 



Preview & Publish Menu 
 Overview 
 Preview Task 

Publish Wizard 
  - Publishing to Blackboard (6.0 or higher) 
  - Publishing to WebCT CE (4.0 or higher) 
  - Publishing to WebCT Vista (2.1 or higher) 
  - Exporting HTML+SWF files 
  - Exporting a SCORM Package 
  - Exporting a SWF Collection 
  - Exporting for iPods, PSP, and other Small Screen Devices 
Print Options 

 
Overview 
The Preview & Publish Menu contains two tasks: Preview and Publish Wizard. The 
Preview task is used to preview the complete Flash object, while the Publish Wizard is 
used to generate and output the Flash object.  
 
Preview 
The Preview task is similar to the preview option that appears in the Edit menu. The 
primary difference here is that all items in the file can be previewed, not just the item 
being edited.  
 
Upon selecting the Preview option, a browser-like window will appear and will show 
what the Flash object will look like when it is published from StudyMate Author. An 
“Activity” list appears at the top of the window and allows you to change the preview to 
a different activity. Note that the Activity list only displays the activities that are 
available for the file currently open. For example, if the StudyMate file only contains 
Multiple Choice items, the Preview task will only list the Practice Quiz and Challenge 
activities. Likewise, if the file only contains One Answer items, it will exclude the 
Practice Quiz and Challenge activities from the Preview task. 
 
During the preview, two options are available at the top right corner of the Flash object: 
“Mark for Delete” and “Edit this Item”. “Mark for Delete” creates a list of items to be 
deleted once the Flash object is closed (you’ll be asked to confirm the deletions at that 
time). “Edit this Item” will close the Preview task immediately and display the item in the 
StudyMate Edit menu.  
 
The Flash object can be viewed with the Settings selections applied or without the 
Settings applied. In most situations you’ll want to see how the Settings (such as question 
randomization) affect the Flash object, but there are times when the original file order is 
preferred for previewing and editing purposes. Select the desired option before clicking 
the Preview button.  
 
 
 



Publish Wizard 
The Publish Wizard is available from the Preview & Publish menu and will guide you 
through the steps of publishing or exporting the final Flash object. 
 

 
 
The first page of the wizard lists the activities and games that can be included with the 
Flash object that is being output. Deselect any activity that you want excluded from the 
Flash object. To include downloadable files for small screen devices (e.g. iPod) select 
this activity (for more information see the section “Exporting for iPods, PSP, and other 
Small Screen Devices”). If an activity is dimmed, it means there aren’t enough items in 
the file for that activity. Click [Next] to continue.  
 
StudyMate Author can publish Flash objects directly to Blackboard 6.0 or higher, 
WebCT CE 4, WebCT CE 6, WebCT Vista 3.0 or higher, and ANGEL 6.3 or higher. If 
you plan to use the Flash object with a different web server or file server, select the 
HTML+SWF option instead. Click [Next] once a selection is made. 
 



Publishing to Blackboard (6.0 or higher) 
StudyMate Author can upload two formats of the Flash activities to a Blackboard server. 
A “standard upload” results in a Flash (.swf) file and an HTML file to be uploaded to the 
specified area in Blackboard. A second option allows a SCORM package to be uploaded 
to the Blackboard course. In order to use the SCORM option, the Blackboard server must 
have the SCORM “Content Player” enabled in the course settings. The main advantage to 
using SCORM packaging is that a student score from any activity can be passed back to 
the SCORM gradebook (only the score for the first attempt is saved). A disadvantage of 
SCORM packaging is that you cannot edit it once it’s been published to the Blackboard 
server. StudyMate Author is also unable to append to or replace a SCORM object once 
published to the server. (For more information on SCORM, see the section “Exporting a 
SCORM Package.”) 
 
The first time StudyMate Author is used to publish a Flash object to Blackboard (version 
6.0 or higher), information must be entered about the Blackboard server and user account. 
 
From the pull-down list labeled “Blackboard” select the “Add New Server” option.  
 

 



As instructed on the screen, the first step is to open a web browser and to go to the Login 
page for your Blackboard course. Be sure that you are at the actual page where you 
enter your user name and password, not a preliminary web page or portal. Copy the 
complete URL for this page and paste it in the field provided. (The easiest way to copy an 
URL that is displayed by a browser is to highlight it with your mouse, click the right 
mouse button, and select “copy”. Then go to the appropriate field in StudyMate Author, 
click the right button again and select “paste”.) 
 
The second step requires you to log into your Blackboard course and select the “Control 
Panel” page. Again, copy the URL address displayed in the browser to the appropriate 
field in StudyMate Author. Upon clicking the “Extract” button, StudyMate Author will 
then fill in the Server Name and Course ID information needed to connect to the course. 
 
The default “server port” is 80, but some institutions use a different port number for their 
Blackboard server. StudyMate Author generally detects the port number automatically 
during the extract step. But if it doesn’t, you can easily identify the correct port number 
by looking at the course URL. For example, the port number for the following 
Blackboard course is 8900: 
http://bb.statecollege.edu:8900/bin/common/course.pl?course_id=_31_1. (If no port 
number is shown in the URL, the setting should be left at 80.) 
 
If your Blackboard system is installed on a "secure server" (https://), the appropriate 
checkbox should be selected. This checkbox should only be selected if the web browser 
address for your course begins with "https://" instead of the normal "http://" (note the 
"s"). 
 
Now provide a short description for the Blackboard server. You can call the server 
anything you want, such as “My Blackboard account”. If you access more than one 
Blackboard server, you will want to select a name that helps distinguish the two servers.  
 
Enter your User Name and Password. This information should be entered exactly as you 
would if using a web browser to access your Blackboard course. If you want StudyMate 
Author to remember your User Name and Password for future sessions, select the 
“Remember my User Name...” checkbox. 
 
Once the server settings have been entered click [OK] to close the window. Confirm that 
you have a live connection to the Internet and click [Next]. StudyMate Author will then 
attempt to connect to your Blackboard server. The hour-glass in Windows will appear 
momentarily. If the connection is successful, the next page of the wizard will appear.  
 
If the connection to the Blackboard course is unsuccessful, an error message will indicate 
that StudyMate Author was unable to connect to the server using the provided settings. If 
this occurs, troubleshoot it as follows:  
 

• Make sure you are running Blackboard 6.0 or higher 
 



• Make sure your connection to the Internet is working properly. 
 
• Double-check the Password and User ID information. In fact, open your 

browser, go to the Blackboard server that hosts your account, and enter the 
identical information. This will confirm that your Blackboard Server is up-
and-running and that your User ID and Password are correct.  

 
• Check the server port and secure server settings are correct 
 
• Make sure you are running the latest version of StudyMate Author (go to 

Help>Check for Update to see if a more current version is available) 
 

Once a successful connection has been made to the Blackboard server and you have 
continued to the next page of the wizard, you are prompted to select a course. Click the 
pull-down list labeled “Course” to view the list of courses. Then select the course to 
which you want to publish the Flash object. The Windows hourglass will again appear as 
StudyMate Author retrieves a list of the Content Areas contained in the course.  
 



 
Now select a Content Area folder or sub-folder where the Flash object should be 
published. For instance, you might select the “Course Documents” folder or a sub-folder 
contained within it. If you are doing a “standard upload” (opposed to a SCORM 
package), the Flash object must be attached to an HTML page within the selected folder. 
So decide whether to append it to an existing HTML page or to create a new HTML page 
altogether. If you are creating a new HTML file, enter the name in the field provided. 
Then click [Next] to continue. 
 
The options on the next page of the wizard are dependent on previous selections. If you 
are doing a “standard upload” and are having StudyMate Author create an entirely new 
HTML page, the option to “Add the StudyMate activity to the new file” is already 
selected. However, if you are appending the object to an existing HTML page, there are 
two options: 1) the Flash object can be placed at the bottom or top of the page or, 2) the 
Flash object can replace an existing StudyMate Flash object that was previously 
published.  
 



 
 
In the next section enter the title that should appear on the HTML page (the text will 
appear directly above the links to the Flash activities). Additional text, such as 
instructions to the student, can be added below the title. 
In the following section, there is an option to provide a title that will appear in the Flash 
activities themselves. For example, the top row in the Challenge game can display a title 
such as “Psychology - Fall Competition!” 
 
StudyMate Author has now gathered all the information needed to publish the StudyMate 
activities to the Blackboard course. Click [Next] to complete the publishing process. 
 



 
 
A status report is generated as StudyMate Author communicates with the Blackboard 
server. You will be told when the publishing step is complete. Then log into your 
Blackboard course and confirm that everything is published to your expectation.  
 
 
Publishing to WebCT CE 4.x 
The first time that StudyMate Author is used to publish a Flash object to WebCT CE 4, 
information must be entered about the WebCT server and user account. 
 
From the pull-down list labeled “WebCT Server” select the “Add New Server” option. 
The following window will appear: 
 



 
 
As instructed on the screen, the first step is to open a web browser and to go to the Login 
page for your WebCT course. Be sure that you are at the actual page where you enter 
your user name and password, not a preliminary web page or portal. Copy the 
complete URL for this page and paste it in the field provided. (The easiest way to copy an 
URL that is displayed by a browser is to highlight it with your mouse, click the right 
mouse button, and select “copy”. Then go to the appropriate field in StudyMate Author, 
click the right button again and select “paste”.) 
 
The second step requires you to log into your WebCT and go to the Home Page. Again, 
copy the URL address displayed in the browser to the appropriate field in StudyMate 
Author. Upon clicking the “Extract” button, StudyMate Author will then fill in the Server 
Name and additional information needed for connecting to the course. 
 
The default “server port” is 80, but some institutions use a different port number for their 
WebCT server. StudyMate Author generally detects the port number automatically 
during the extract step. But if it doesn’t, you can easily identify the correct port number 
by looking at the course URL. For example, the port number for the following WebCT 



course is 8900: http://www.webct.statecollege.edu:8900. (If no port number is shown in 
the URL, the setting should be left at 80.) 
 
If your WebCT system is installed on a "secure server" (https://), the appropriate 
checkbox should be selected. This checkbox should only be selected if the web browser 
address for your course begins with "https://" instead of the normal "http://" (note the 
"s"). 
 
Now provide a short description for the WebCT server. You can call the server anything 
you want, such as “My WebCT account”. If you access more than one WebCT server, 
you will want to select a name that helps distinguish the two servers.  
 
Enter your User Name and Password. This information should be entered exactly as you 
would if using a web browser to access your WebCT course. If you want StudyMate 
Author to remember your User Name and Password for future sessions, select the 
“Remember my User Name...” checkbox. 
 
Once the server settings have been entered click [OK] to close the window. Confirm that 
you have a live connection to the Internet and click [Next]. StudyMate Author will then 
attempt to connect to your WebCT server. The hour-glass in Windows will appear 
momentarily. If the connection is successful, the next page of the wizard will appear.  
 
If the connection to the WebCT course is unsuccessful, an error message will indicate 
that StudyMate Author was unable to connect to the server using the provided settings. If 
this occurs, troubleshoot it as follows:  
 

• Make sure you are running WebCT CE 4.x 
 

• Make sure your connection to the Internet is working properly. 
 
• Double-check the Password and User ID information. In fact, open your 

browser, go to the WebCT server that hosts your account, and enter the 
identical information. This will confirm that your WebCT server is up-and-
running and that your User ID and Password are correct.  

 
• Check the server port and secure server settings are correct 
 
• Make sure you are running the latest version of StudyMate Author (go to 

Help>Check for Update to see if a more current version is available) 
 

Once a successful connection has been made to the WebCT server and you have 
continued to the next page of the wizard, you’ll be prompted to select a course. Click the 
pull-down list labeled “Course” to view the list of courses. Then select the course to 
which you want to publish the Flash object. The Windows hourglass will again appear as 
StudyMate Author retrieves a list of the Organizer Pages, Content Modules, and HTML 
files contained in the course.  



 
 
Now select the location in the course where the Flash object should be published. If the 
object is being published to a Content Module, it must be attached to an HTML page 
within the module. So decide whether you want to append it to an existing HTML page 
or whether you want to create an entirely new HTML page. If you are creating a new 
HTML file, enter the name in the field provided. Then click [Next] to continue. 
 
The options on the next page of the wizard depend on what was selected in the previous 
step. If you are having StudyMate Author create an entirely new HTML page, the option 
to “Add the StudyMate activity to this page or file” is already selected. However, if you 
are appending the object to an existing HTML page, there are two options: 1) the Flash 
object can be placed at the bottom or top of the page, or, 2) the Flash object can replace 
an existing StudyMate Flash object that was previously published.  
 
 



 
 
In the next section enter the title that should appear on the HTML page (the text will 
appear directly above the links to the Flash activities). Additional text, such as 
instructions to the student, can be added below the title. 
 
In the third and final section, there is an option to provide a title that will appear in the 
Flash activities themselves. For example, the top row in the Challenge game can display 
a title such as “Psychology - Fall Competition!” 
 
StudyMate Author has now gathered all the information needed to publish the StudyMate 
activities to the WebCT course. Click [Next] to complete the publishing process. 
 



 
 
A status report is generated as StudyMate Author communicates with the WebCT server. 
If the Flash object is being published to a Content Module, a message will appear at the 
end of the publishing step that asks whether you want to update the Student View. (Even 
though a WebCT designer can immediately see the Flash object once it’s been published 
to the WebCT course, students won’t be able to see it until you have updated the Student 
View. We recommend that you answer “Yes” to this prompt.) 
 
The publishing step is complete. Log into your WebCT course and confirm that 
everything is published to your expectation.  
 
 
Publishing to WebCT Vista (3.0 or higher) or WebCT CE 6  
StudyMate Author can upload two formats of the Flash activities to a WebCT Vista/CE 6 
server. A “standard upload” results in a Flash (.swf) file and an HTML file to be 
uploaded to the specified area in WebCT Vista/CE 6. A second option allows a SCORM 
package to be uploaded to the course or section. The main advantage to using SCORM 
packaging is that a student score from any activity can be passed back to the SCORM 
gradebook (only the score for the first attempt is saved). A disadvantage of SCORM 
packaging is that you cannot edit it once it’s been published to the WebCT server. 
StudyMate Author is also unable to append to or replace a SCORM object once published 
to the server. (For more information on SCORM, see the section “Exporting a SCORM 
Package.”) 
 



The first time StudyMate Author is used to publish a Flash object to WebCT Vista/CE 6, 
information must be entered about the WebCT server and user account. 
From the pull-down list labeled “Vista Server” select the “Add New Server” option. The 
following window will appear: 
 

 
 
The first step requires you to start a web browser, log into your Vista course, and go to 
any group or section. For the second step, copy the complete URL for this page and paste 
it in the field provided. (The easiest way to copy the URL is to highlight it with your 
mouse, click the right mouse button, and select “copy”. Then go to the appropriate field 
in Respondus, click the right button again and select “paste”.) 
 
Before proceeding with the third step, make sure your Internet connection is live. Then 
click the “Extract” button. For the fourth step, click the “Institutions” button and then 
choose your institution from the list that becomes available. 
 
For the fifth step, enter whatever name you like for the description of the WebCT Vista 
server, such as “My Vista Server”. Also enter your designer-level User Name and 
Password exactly as you would if using a web browser to access your WebCT Vista 
courses. (Note, you must have a designer-level -- or higher -- account to publish exams to 
Vista. You cannot create exams in Vista using instructor-level, teaching assistant, or 
student accounts.)  
 



Finally, if you want StudyMate Author to remember your User Name and Password for 
future sessions, select the “Remember my User Name...” checkbox.  
Once the server settings have been entered click [OK] to close the window. Confirm that 
you have a live connection to the Internet and click [Next]. StudyMate Author will then 
attempt to connect to your WebCT server. The hour-glass in Windows will appear 
momentarily. If the connection is successful, the next page of the wizard will appear.  
 
StudyMate Author now looks up the Groups and Sections that are available to you and 
displays them in the drop-down list. Select the group or section to which the Flash object 
will be published. The Windows’ hourglass will again appear as Respondus determines 
whether additional templates are associated with the Group or Section that was selected. 
If more than one template is available, select the one to be used. 
 

 
 
Now select the location in the course where the Flash object should be published, either 
an Organizer Page or a Learning Module. For a “standard upload,” the HTML/SWF files 
need to be attached to an HTML page if published to a Learning Module. So decide 



whether to append it to an existing HTML page or whether to have it create an entirely 
new HTML page. If you are creating a new HTML file, enter the name in the field 
provided. Then click [Next] to continue. 
 
The options on the next page of the wizard are dependent on previous selections. If you 
are doing a standard upload of HTML/SWF files and are having StudyMate Author 
create an entirely new HTML page, the option to “Add the StudyMate activity to this 
page or file” is already selected. However, if you are appending the activities to an 
existing HTML page, there are two options: 1) the Flash object can be placed at the 
bottom or top of the page, or, 2) the Flash object can replace an existing StudyMate Flash 
object that was previously published. (These options won’t appear if publishing a 
SCORM package.) 
 

 
 
In the next section enter the title that should appear on the HTML page (the text will 
appear directly above the links for the Flash activities). Additional text, such as 
instructions to the student, can be added below the title. 



 
In the following section there is an option to provide a title that will appear in the Flash 
activities themselves. For example, the top row in the Challenge game can display a title 
such as “Discovery & Exploration”. 
 
StudyMate Author has now gathered all the information needed to publish the StudyMate 
activities to the WebCT course. Click [Next] to complete the publishing process. 
 

 
 
A status report is generated as StudyMate Author communicates with the Vista server. 
Once the publishing steps are complete, log into your Vista course and confirm that 
everything is published to your expectation.  
 
 
Publishing to ANGEL (6.3 or higher)  
StudyMate Author can upload two formats of the Flash activities to an ANGEL server. A 
“standard upload” results in a Flash (.swf) file and an HTML file being uploaded to the 



specified area in ANGEL. A second option allows a SCORM package to be uploaded to 
the ANGEL lesson area. The main advantage to using SCORM packaging is that a 
student score from any activity can be passed back to the SCORM gradebook (only the 
score for the first attempt is saved). A disadvantage of SCORM packaging is that you 
cannot edit it once it’s been published to the ANGEL server. StudyMate Author is also 
unable to append to or replace a SCORM object once published to the server. (For more 
information on SCORM, see the section “Exporting a SCORM Package.”) 
 
The first time StudyMate Author is used to publish activities to ANGEL (version 6.3 or 
higher), information must be entered about the ANGEL server and user account. 
 
From the pull-down list labeled “ANGEL Server,” select the “Add New Server” option. 
The following window will appear: 
 

 
 
The first step requires you to start a web browser, log into your ANGEL course, and go to 
the course list page. For the second step, copy the complete URL for this page and paste 
it in the field provided. (The easiest way to copy the URL is to highlight it with your 
mouse, click the right mouse button, and select “copy.” Then go to the appropriate field 
in Respondus, click the right button again and select “paste.”) 
 
Before proceeding with the third step, make sure your Internet connection is live. Then 
click the “Extract” button.  
 



For the fourth step, enter whatever name you like for the description of the ANGEL 
server, such as “My ANGEL Server.” Also enter your User Name and Password exactly 
as you would if using a web browser to access your ANGEL course.  
 
Finally, if you want StudyMate Author to remember your User Name and Password for 
future sessions, select the “Remember my User Name...” checkbox.  
 
Once the server settings have been entered click [OK]. Click [Next] to continue to the 
next page of the wizard. 
 
StudyMate Author now looks up the courses that are available to you and displays them 
in the drop-down list. Select the course to which the Flash object will be published.  
 

 
 
Now select the lesson area and folder to where the Flash object should be published. 
Indicate whether StudyMate Author should replace the selected file item or create a new 
one. In the latter case, enter a file name and a subtitle. Click [Next] to continue. 



 
The display of the next page of the wizard depends on previous selections. If a standard 
set of HTML/SWF files are being uploaded, then enter a “title” for the HTML page that 
will display the links for the StudyMate activities. Additional text can also appear below 
the title.  
 

 
 
Some StudyMate activities display a title within the game or activity itself. For example, 
the top section of the Challenge game can display a title such as “History of Algorithms”. 
Enter this text if you like. 
 
StudyMate Author now has all the information needed to publish the StudyMate activities 
to the ANGEL course. Click [Next] to complete the publishing process. 
 



 
 
A status report is generated as StudyMate Author communicates with the ANGEL server. 
Once the publishing steps are complete, log into the ANGEL course and confirm that 
everything is published to your expectation.  
 
 
Exporting HTML+SWF Files 
If you want to export a StudyMate activity so that it can be added to a web page, you 
must use a bit of HTML code. StudyMate Author will provide the needed HTML code 
when the SWF is exported.  
 
Start the StudyMate Publish Wizard and select the activities to be included with the Flash 
file. On the next page of the wizard select the “HTML+SWF” option and click [Next]. 
 
You are now prompted to enter the title that should appear on the HTML page (the title 
text will appear directly above the links to the Flash activities). Additional text, such as 
instructions to the student, can be added below the title. 
 
In the next section, there is an option to provide a title that will appear in the Flash 
activities themselves. For example, the top row in the Challenge game can display a title 
such as “Psychology - Fall Competition!” 
 



Finally, click the [Save As] button and browse to a location on your hard drive to where 
the Flash file and HTML file should be saved. Once a folder is selected, click [Finish] to 
complete the export process. 
 
In order to view the exported StudyMate activities, you must open the HTML file that 
was exported, not the .swf file itself. (The browser needs the HTML code, including 
settings contained in the HTML file, in order to properly start the Flash object.)  
 
The final step is to upload the files to your web server. You can either upload both the 
HTML page and the SWF file to the same folder on the web server, or you can add the 
body of the HTML file to one of your own pages and upload only the SWF file (place it 
in the same folder).  
 
 
Exporting a SCORM Package 
The Shareable Content Object Reference Module (SCORM) is an XML specification that 
enables the reuse and migration of web-based learning content in different environments 
and products. Many of the leading course management systems and learning management 
systems support SCORM, including WebCT Vista/CE6, ANGEL, and Blackboard.  
 
The Publish Wizard in StudyMate Author includes a SCORM option within the 
Blackboard, WebCT Vista/CE6, and ANGEL publishing options. It’s easier to use these 
integrated publishing options for SCORM, rather than manually exporting it as a 
SCORM 1.2 package, as is required for use with other SCORM-compliant systems.  
 
StudyMate supports the “grade” feature in SCORM, which allows a score to be passed 
from the Flash object to the e-learning system. SCORM only allows one grade to be 
passed from the object to an e-learning system's gradebook.  By default, the “Quiz” 
activity is used for generating the grade, but it is possible to designate a different 
StudyMate activity for this purpose within the Publish Wizard.  
 
StudyMate also supports the “time” feature which indicates how much time a student 
spent on each StudyMate activity. However, this is an optional feature in the SCORM 
specification and it isn’t supported by many e-learning systems. 
 
 
Exporting a SWF “Collection” 
Exporting StudyMate objects to a SWF Collection allows for the creation of individual 
activities that do not require an accompanying HTML page for "launching" purposes. 
(Exporting a SWF Collection is an advanced feature and it is important to know that the 
HTML + SWF publish option is a better choice for most exporting purposes.)   
 
When exporting to a SWF Collection each activity is published as a separate Flash file, 
such as History_flash.swf (Flash Cards) or History_quiz.swf (Quiz).  This approach 
makes the overall size of the collection much larger as each file is nearly as large as the 
single shared SWF.   



Exporting for iPods, PSP, and other Small Screen Devices 
The Publish Wizard includes an option to generate a file that is usable with iPods, Sony 
PSP, and certain other “small screen devices”.  When this option is selected in the 
Publish Wizard, activities published to the Course Management System can be 
downloaded by the student for use on their iPod or small screen device Up to four 
activities can be generated for small screen devices: Fact Cards (from the “No Answer” 
template), Flash Cards (from the “One Answer” Template), Multiple Choice (from the 
“Multiple Choice” template, and Calculated (from the "Calculated" template). The 
activities differ from their Flash counterparts in that they are converted to static images 
for viewing on the device.  
 
Settings for files created for small screen devices can be found in the Settings Menu 
within the Small Screen Devices tab  
 
If the setting for small screen devices is selected on the first step of the Publish Wizard, 
download links for these files will then appear on the HTML page that lists the other 
Flash activities that are available.  
 

 
 
Once the file with the appropriate resolution is downloaded, it is then transferred to the 
device using software (such as iTunes) or by copying the files to a flash memory card.  
Instructions for downloading activities and then transferring them to a small screen 
device can be found at http://www.respondus.com/studymate/ipod.shtml.  
 
 
 
 
 



 
Print Options 
StudyMate Author allows you to print questions and items or save them to MS Word 
format for further enhancement and printing. To begin, go to the Preview and Publish 
menu in StudyMate Author and select the Print Options tab. 
 
The screen now displays the printing options available in StudyMate Author. The first 
step is to select the Formatting options that are desired, including the type and range of 
items to be included in the printout. 
 
The second step allows you to specify the “header” information to appear at the top of 
pages, such as a person’s name, the file name, or the date.  
 
In the final step, you can preview the file (formatted selections will be displayed), save 
the file to MS Word or rich-text format, or send the file directly to a printer.  
 
 
 



Other Tools & Features 
Overview 
Preferences 
Save As Copy 
Check for Update 

 
Overview 
There are several additional tools in StudyMate Author that offer a range of functions. 
Each of these is discussed below.  
 
 
Preferences 
Preference settings can be accessed from the File menu bar. The first item allows you to 
move or rename the StudyMate Projects folder. If the folder is moved in Windows, it’s 
essential that the location be updated here.  
 
The second item in preferences determines whether StudyMate Author will automatically 
check for product updates. The checking occurs every few weeks. 
 
The next item allows you to enter or change the default author name for StudyMate 
project files. 
 
The next two settings determine whether the answer choices for multiple choice questions 
will be randomized when questions are imported or created new. Note that changing this 
setting doesn’t affect questions that are already contained in the project, only new 
questions that are added to it.  
 
The final option specifies the language setting to be used when new files are created. 
 
 
Save As Copy 
The Save as Copy tool, located on the File pull-down menu, can be used to create a copy 
of the currently open project file. After the project is saved, StudyMate Author will begin 
using the newly named project file. 
 
If you plan to move a StudyMate project to another computer, and if the StudyMate 
project contains embedded objects such as equations or images, be sure to use the “zip” 
feature that’s available in Save as Copy (otherwise these objects will be missing when the 
file is opened on the other computer). With the Save as Copy window displayed, change 
the “Save as Type” pull-down list to “zip archive”. All files associated with the 
StudyMate project will be stored in the zip archive.  
 
 
Item Title Tool 
There are situations where it is desirable to rename all the titles in the StudyMate project 
file to provide a consistent look or numbering sequence. For example, if questions are 



copied or imported from a variety of sources the resulting titles may look inconsistent and 
haphazard.  
 
The Item Title Tool, located under File on the menu bar, lets a “stem” (or prefix) be 
specified for item titles. Consecutive numbering will automatically be generated for the 
text that appears after the stem, beginning with 1 (or 01, or 001, etc.). For example, if you 
enter “Chapter1-” as the stem text, and then select “001” as the format for the numbering 
scheme, the title for the first item will be changed to Chapter1-001, the title for the 
second item will be changed to Chapter1-002, and so on. If a range is specified for the 
titles being changed, even more specific titles can be provided throughout the file. For 
instance, questions 1-20 might use the stem “Ch1-Unit1-” and questions 21-30 might use 
the stem “Ch1-Unit2-” and so forth. 
 
 
Properties 
Select properties from File on the menu bar to view or change the properties for the 
currently open file. There are three fields that can be edited: Author, File Description, 
and Keywords.  
 
 
Check for Update 
The “Check for Update” tool, located on the Help menu bar, provides an easy way to see 
if an update is available for StudyMate Author. Every few weeks, StudyMate Author will 
generate a message that asks whether it can check for an update. No information about 
your computer hardware and software is collected by Respondus, Inc. during this 
process. Instead, the StudyMate Author software retrieves information from 
Respondus.com and will display a message if an update is available. You will then have 
the choice of upgrading to the latest version of the software.  
 
To manually check for a software update, select the “Check for Update” option from the 
Help pull-down menu (you will need a live Internet connection). StudyMate Author will 
instantly return a message indicating whether an upgrade is available. If an upgrade to 
StudyMate Author is available, you can let it download the required file(s) automatically 
and update the software for you. This is the easiest way to apply a patch or upgrade. 
 
If you prefer that StudyMate Author does not periodically prompt you to check for an 
update, go to the File menu, select Preferences, and unselect the appropriate checkbox 
under the General tab.  
 
 
 
 
 
 
 
 



Disclaimer of Warranty   
While Respondus, Inc. has tried to ensure the dependability of the software and 
documentation, it is provided "as is" without warranty of any kind.  Agents of the 
supplier may have made statements about this software.  Any such statements do not 
constitute warranties and shall not be relied on by individuals in deciding to use the 
program.   
 
Because of the diversity of conditions and hardware under which this program may be 
used, no warranty of fitness for a particular purpose is offered. Test the program 
thoroughly before relying on it. You assume the entire risk of using the program. 
Respondus, Inc. shall not be liable for any expense, claim, liability, loss, or damage 
(including any incidental or consequential damage), loss of profits, loss of reputation, or 
any loss whatever direct or indirect, by you from either the use of or the inability to use 
the software.  
 
 
Copyright, Ownership, and Use of Software   
All software, with exception of the Equation Editor, remains the property of Respondus, 
Inc. The software and written materials are copyrighted.  This license is not a sale of the 
original software or any copy.  You own the physical media on which the software is 
originally or subsequently encoded, but Respondus Inc. retains title and ownership of the 
software on all media.  
 
You are not permitted to install the executable code version of this product on a network 
server or virtual server. You may not customize the Product. Except as otherwise 
permitted by written consent, you may not: (i) modify or create any derivative works of 
the Product or documentation, including translation or localization; (ii) decompile, 
disassemble, reverse engineer, or otherwise attempt to derive the source code for the 
Product; (iii) redistribute, encumber, sell, rent, lease, sublicense, or otherwise transfer 
rights to the Product; or, (iv) remove or alter any trademark, logo, copyright or other 
proprietary notices, legends, symbols or labels in the Product. 
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